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accurate. However, it is inevitable given the quantities involved that one or more mistakes may have been made. UK-Elect 
is supplied "as is". No liability can be accepted for consequential, incidental or other damages resulting from use of this 
program or its associated data. No liability can be accepted for forecasting the result of an election wrongly, or for 
forecasting a result differently from that hoped for by the user. No responsibility or blame can be accepted for the actual 
result of any election. 
 
UK-Elect is continually being improved; therefore the current version of UK-Elect may include additional features. 
Similarly, earlier versions may not contain all the functionality covered in this manual. 
 
Please notify the authors immediately of any obvious errors. Notified errors will be corrected in subsequent releases. 
 

SUPPORT AND UPGRADE INFORMATION 
For support and upgrade information please contact:  
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1. Introducing UK-Elect 
UK-Elect is a comprehensive British election viewer and analyser that enables easy and 
sophisticated forecasting of all British elections.  

 
With UK-Elect you can: 
 analyse past election results (including referendums) and forecast future elections 
 simulate tactical voting, the incumbency advantage, and the use of different electoral systems 
 examine election results and forecasts graphically using maps and charts 
 easily and automatically browse information available from other sources, e.g. Wikipedia 
 
UK-Elect includes: 
 1983 to 2019 General Election results, and a summary of General Elections since 1900 
 1984, 1989, 1994, 1999, 2004, 2009, 2014 and 2019 UK European Parliament results 
 1975 and 2016 European, 1997 and 2014 Scottish,  1997 and 2011 Welsh, and 2011 AV 

referendums 
 1999, 2003, 2007, 2011, 2016 and 2021 Scottish Parliament and Welsh Assembly results 
 2000, 2004, 2008 , 2012, 2016 and 2021 London Assembly and Mayoral results 
 2003, 2007, 2011, 2016, 2017 and 2022 Northern Ireland Assembly results 
 Dozens of other election results (hundreds are included in the Professional Version) 
 



UK-Elect Page 5 
 

UK-Elect supports many types of election: 
 General Election 
 European Parliament 
 London, County and local councils 
 Scottish Parliament and Welsh Assembly 
 Referendums 
 
Analyse results in many ways: 

Results can be filtered and sorted by, for example, swing percentages. If you want to display on a 
map all seats where Labour is less than 500 votes behind the Tories, UK-Elect is the tool to use. 
 

Display results in many ways: 

Map markers can be used to indicate, for example, gains, losses, or summary pie-charts showing 
vote proportions and distributions. 
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2. Getting Started 

2.1. System Requirements 
UK-Elect requires: 
 
 Microsoft Windows 10 or later (it may work on earlier versions but this is no longer tested) 
 Use on some Apple Macintosh and Linux computers is possible via a suitable Windows 

Emulator, but this operation cannot be guaranteed. If you would like to try this (and receive a 
refund if it doesn’t work) then please ask. 

  monitor with resolution of at least 1024 x 768 (the higher the resolution, the better) 

2.2. To Install and Run UK-Elect From A Supplied Setup .Exe File 
1. Follow the supplied instructions. If no instructions are provided then simply run the 

supplied setup .exe file 

2.3. To Install and Run UK-Elect From A Supplied .Zip  File 
1. Unzip the file using your preferred unzipping tool – e.g. click on it with the right mouse 

button and select the extract option. Once all the files have been extracted to a folder, run 
the   setup .exe file from that folder. 

2.4. To Install and Run UK-Elect From CD 
1. Insert the CD into your CD drive. The CD should automatically start the installation program. 
2. As an alternative, use the Windows Start button, select Run… and type d:\install\setup, 

where d: is replaced by the appropriate drive character. 
3. After completing the installation routine, double-click on the UK-Elect icon in the UK-Elect 

group that will have been added to the Start menu. 
4. If there are any problems with installation, then UK-Elect can also be run directly from the 

CD (run d:\ukelect\ukelect, where d: is replaced by the appropriate drive character), or the 
contents of the Ukelect directory copied onto the hard drive 

2.5. About this Manual 
UK-Elect is continually being improved, therefore the current version of UK-Elect may include 
additional features. Similarly, versions earlier than the current version may not contain all the 
functionality covered in this manual. In addition, not all Editions of UK-Elect contain all the 
features found in the Professional Edition, e.g. the General Elections Edition primarily contains 
material related to General Elections, and the Trial Version (when available) contains a subset of 
the election results and maps found in the General Elections Edition. 
 
Please note that the most up to date version of this manual is generally available from the 
downloads page on the www.ukelect.co.uk website. If there are any features in UK-Elect not 
covered by this version of the manual, then it is worth checking online for an update. 
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3. Forecasting election results 
Using UK-Elect it is possible to forecast the results of any British election (e.g. including Scottish 
Parliament, Welsh Assembly, UK European Parliament, London, and Scottish/English/Welsh 
local council elections as well as General Elections). Electoral systems supported include First 
Past The Post, Additional Member (AMS), Party List, Single Transferable Vote (STV), 
Supplementary Vote (SV), Alternative Vote and Two Round. UK-Elect supports six main types 
of forecasting method - Uniform National Swing, Proportional, Proportional Loss, Proportional 
Loss With Threshold, a UK-Elect specific method, and Custom (which provides access to all 
settings and to a further UK-Elect “Experimental” method), and provides a wealth of options to 
fine-tune forecasting, including support for statistical seat probability calculations, and support for 
forecasting based partly on local opinion polls. Details of these methods are given in Appendix A. 
Generally the Uniform National Swing method is a “safe” method, unlikely to produce wildly 
wrong results, and is the method favoured by many “serious” psephologists and political 
scientists. Proportional methods (especially the proportional loss with threshold method variant 
called the Strong Transition Model) have also proved popular online and in the media in recent 
elections, with advocates claiming more accurate results are achieved using them. The discussion 
is ongoing, but with UK-Elect it is possible to easily try the various alternatives. 
 

3.1. Making a quick guided forecast 
 
To make a quick forecast, with guided prompts, simply start UK-Elect and make sure a suitable 
election file is loaded, e.g. the 2019 UK General Election file can be used for forecasting the next 
General Election, or the 2021 Scottish Parliament file for forecasting the next Scottish Parliament 
results. Then choose the Guided Forecast option on the Forecast menu, or press the green button 
on the main toolbar. The first Guided Forecast question box will appear. 

 
 
UK-Elect will ask you a series of questions, and will configure the forecasting options 
appropriately, prompting you to enter the opinion poll percentages when necessary. 
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UK-Elect will offer the option to use the most appropriate values for your selected forecast type. 

 
 
After all the questions have been answered, and opinion poll data entered, UK-Electwillprovide a 
summary of the current configuration. 
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The forecast will then be made for the areas that you have selected using the forecast settings 
which you have chosen.  
 

 
 
UK-Elect will then offer the option to save the newly edited settings, which can then be accessed 
on the Forecasting Configuration dialog. A forecast can always be made based directly on this 
current forecast configuration, by choosing the normal ‘Forecast’ option on the forecast menu, or 
pressing the yellow button on the main toolbar. 
  
For details of how to view and analyse this and other forecasts and previous results see Section 4. 
To learn more about configuring election forecasts, see the rest of this section. 
 

3.2. Configuring the forecast 

The percentages associated with the forecast can be entered via the Forecast/Opinion Poll 
Percentages menu options, for the overall summary and for individual regions – including, in the 
case of AMS elections such as those for Scotland, Wales and London, for the overall AMS 



UK-Elect Page 11 
 

regional vote total, As well as opinion poll percentages, actual percentages generated at a previous 
election can also be loaded, on a UK, GB, filtered or regional basis. 
 

 
 
The opinion poll dialog (along with the forecasting configuration dialog) also provides a 
convenient means of selecting a “base election”. This (normally the previous election) is the 
election used as a forecast or electoral system conversion base, i.e. it is treated as if it was the 
previous election. 
 
The percentages used for forecasting can be viewed via the Forecasting Target Percentages 
dialog. Target percentages can be opinion poll percentages, or result-based percentages, or a 
weighted mix of the two. The Forecast button can be used to make a forecast directly from the 
dialog. The Opinion Poll button gives access to the Opinion Poll configuration dialog. The 
Recalculate option recalculates the target percentages, according to current configuration settings. 
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When using the Additional Member System (AMS), the AMS Regional Opinion Poll Percentages 
option can be used to configure the regional percentages (these can differ from the constituency 
percentages, since some people “split” their votes). 
 
To do a detailed forecast using local poll percentages for a UK region or country such as 
Scotland, set the forecast area to regional and select "Scotland" (or Wales, etc.) Then go to the 
opinion poll percentages option on the Forecast Menu and press Last Election Regional % (to get 
last election percentages for the selected region) and enter the latest Scottish (or wherever) poll 
percentages. Then use the opinion poll based forecast option on the Forecast Menu to predict the 
results for the selected region. 
 
To forecast a local (e.g. Council) election, load the relevant election results; then select the 
"opinion poll percentages" option from the forecast menu. If local opinion poll percentages are 
known then they can be entered directly and a forecast made. Alternatively, if the national 
percentages at the time of the last local election are known (e.g. from an election or opinion poll) 
then UK-Elect can be set up to automatically do a conversion. First, enter the national percentages 
from the time of the last local election and then use the “Save as Local/Nat Base %” button. Now 
you can enter current national poll percentages and then press the “Nat->Local%” button to 
convert them to current local percentages, which can be used for the forecast. 
 
If forecasting an election that uses the AMS system (e.g. the Scottish Parliament or Welsh 
Assembly) it is important to make sure that the “Use AMS Regional Percentages” option is 
checked if regional poll percentages have been entered - otherwise the “main” opinion poll 
percentages will also be used for the AMS member forecasting. 
 

3.3. Specifying the forecasting method 
The choice of forecasting method, and all the forecasting parameters, can be configured via the 
Forecast/Forecasting Configuration… menu option. These options can look rather daunting at 
first glance but provide a wealth of configurability. If you would just prefer to use a 
straightforward traditional forecasting method then just press the “Simple” button which 
will configure the settings for a simple form of Uniform National Swing. For a slightly more 
adventurous forecast (which attempts to better forecast most modern British elections) press the 
“Default” button which will set a few additional parameters to recommended values. For 
something still more different press the “Alternative” button and see which options it sets -you 
can read about them below. 
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 Forecasting Method - whether Uniform National Swing, Proportional, Proportional Loss, Proportional Loss 
With Threshold, a current UK-Elect-specific method (this may change and evolve between UK-Elect 
versions), or Custom, which allows additional options to be configured, (see Appendix A for a detailed 
discussion of the different methods). If you are not sure what option to choose then it is recommended that 
you use Uniform National Swing. 

 Forecasting/Conversion Base Election – Can be used to forecast and/or convert between electoral systems 
based on a specific previous election. (The default is the previous election or notional result set.) 

 Election Date – Date (if known) of the next election. If the “adjust Target Percentages When Forecasting” 
option is checked then the current opinion poll percentages will be blended with the party percentages 
recorded at  the previous election, depending on how long it is until the next election (provided that the next 
election date is known). This reflects the fact that party support often returns closer to the level at the 
previous election during the run-up to a new election. 

 Forecasting Area – whether to forecast on a UK, GB, filtered, regional or combined basis. GB is the normal 
default as most published opinion poll data in the UK is GB only (as politics in Northern Ireland is quite 
distinct). There is also a highly convenient combined forecasting option which will automatically forecast 
one or more selected regions first using the regional percentages, and then (optionally) Great Britain using 
the main percentages, and without overwriting the regional results. The opinion poll data for Scotland, 
Wales, London, Northern Ireland and any one other region is stored separately from the overall opinion poll 
data, and can be accessed via options on the forecasting menu. When using the combine forecasting option  
these percentages are always used for the appropriate region, but if the forecast area is set to regional (e.g. to 
Scotland) then there is an additional option (located in the “Source of Forecasting Target Percentages” area) 
to use regional percentages for the forecast or to use overall percentages.  

 Source of Target Percentages - whether to forecast using opinion poll, by-election, constituency opinion 
poll or result-based percentages, or a mix. It is also possible to forecast based on a selection of 
constituencies from any of these sources. An option can be set to use the regional percentages when 
forecasting a single region. (When forecasting using the combined GB/regional setting the regional 
percentages are always used for the regional forecast.) Note that the forecast target percentage calculations 
for the main poll percentages and the regional percentages are separate – e.g. if by-elections are set as the 
source, and the current region is Scotland then only Scottish by-elections will be used when calculating the 
regional percentages. Note also that for AMS elections (such as the Scottish Parliament) the regional opinion 
poll percentages are always used as the target regional percentages. 

 Assume polls prompt using actual candidates in each constituency – whether the polls used as input 
prompted the voters with the actual local parties and candidates standing in each constituency. This can 
make a considerable difference to forecasting where a party is only standing in some constituencies – e.g. a 
party standing in 50% of constituencies and having an average support level of 8% in each would show as 
having 4% support overall. When forecasting where the final candidate list is known UK-Elect needs to 
know whether the national/regional polls take account of this factor. 

 Max Iterations - this option allows the maximum number of forecasting iterations to be specified. 
Specifying a higher number will slow down forecasting but produce a more accurate result. After each 
iteration UK-Elect will add up the percentages, and compare the total percentages for each party with the 
target percentages. Adjustments may then need to be made to achieve the correct result - this can be 
particularly important if tactical voting and incumbency has been allowed for. 

 Leave SNP/PC/NI parties unchanged if no target percentages not known - this controls whether 
forecasts are made for the SNP, Plaid Cymru and the Northern Ireland parties even when the change in their 
votes is not known. If checked (or if the “leave minor parties unchanged” option is checked), then their votes 
in such cases will be left the same as at the previous election unless their vote is specified on the opinion poll 
dialog, or calculated as one of the top values based on some past election. (In practice this option rarely 
affects the SNP as their votes are usually entered on the poll percentages dialog, but does affect the others.) 
If unchecked, then forecasts will be made on the basis of overall changes in the other party vote totals. The 
normal default for this option is checked (on).   

 Leave minor parties unchanged - if set, the votes for all non-major parties that do have their vote 
explicitly set will be left unchanged during forecasting, otherwise they will be adjusted proportionately. The 
normal default for this option is unchecked (off). 

 Tactical Voters Percent - maximum percentage of people prepared to vote tactically. Where tactical voting 
occurs (see advanced settings below) this percentage of voters who would otherwise have supported third 
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and subsequent candidates will switch to the party which was second placed at the last election. See Section 
3.5 for details of tactical voting configuration. 

 Add Incumbency Percentages – enables the use of additional incumbency percentages. See Section 3.5 for 
details of incumbency configuration. 

 Use Constituency Opinion Polls – whether to use constituency opinion polls (accessed from the elections 
menu like by-elections) as part of the forecasting calculations. A weighting of 0 to 100% can be assigned to 
the polls, where 75% would indicate that the poll is given three times as much weighting as the initial 
forecast – so the final result would be heavily affected by the poll. The “reduced by .. % p/day” amount 
can be used to progressively reduce the weighting of individual polls over time, e.g. if  a poll is 30 days old 
and this figure is set to 0.2%, then the weighting would be reduced by 6%,so if the original weighting was 
75%, the new value would be 69%. The “Adjust by change in opinion polls since constit. poll date” 
option will, where data is available and included with UK-Elect, automatically take account of any change in 
the regional or national polls since the date when the poll was taken – e.g. if the national or regional Labour 
Party vote was 5% higher when the poll was taken than currently then this will be factored into the 
forecasting calculation. 

 Use By-elections – works in the same way as the “Use Constituency Opinion Polls” option but with by-
election results. 

 Calculate Seat Win Probabilities – this option can be used to calculate and display the probability that a 
particular party will win a seat based on the forecast vote percentages for that seat – e.g. if the lead of a party 
is very large the probability will be close to 100%, but if it is narrow it might be less than 50% (The 
probabilities are displayed as percentages for convenience.) The algorithm used for this calculation is based 
on the Curtice/Firth method that has been used by the BBC for projections based on its exit polls, and the 
tuning constants are available on the advanced dialog. 

 Automatically Scale SNP And Plaid Cymru UNS Swings – this option takes account of the fact that the 
SNP and Plaid Cymru only contest a fraction of the overall GB seats, converting their projected national 
swings from UK or GB figures to the Scottish or Welsh equivalents. If forecasting a General Election using 
UK or GB figures, and using a method that includes any UNS calculations, then this option needs to be set 
on.  

 Use Brexit Leave Percentages – this option takes account of the actual or estimated 2016 Brexit 
referendum leave percentages where available for a constituency. They are used to fine tune forecasting for 
the parties that campaigned on the basis of Brexit (the Brexit Party and UKIP), typically increasing or 
reducing their vote in proportion to the size of leave support in a constituency. Other parties will 
proportionally gain or lose as the inverse of this effect.  

 Overall Brexit Importance To Voters – this option is used to scale the effect of forecasting using the 
Brexit referendum leave percentages. The range is 0 to 10, where 10 indicates that Brexit is seen as 
overwhelmingly the most important issue to voters, 8 as extremely important, 6 as very important, 4 as 
important, 2 as quite important and 1 as not important. 

 Use Brexit Tactical Voting – if this is enabled then forecasting will assume that a percentage of people will 
vote tactically for either Leave or Remain supporting parties based on their stance on Brexit. The amount of 
this tactical voting will depend on the local constituency situation (whether inclined to leave or remain, and 
the anticipated margins between 1st, 2nd and 3rd parties) and on the overall Brexit importance to voters 
value (set by the option on the forecasting configuration dialog).  

 Auto Add New Parties/Candidates Automatically – Allows automatic addition of UKIP, Green, Brexit 
Party and up to three other specified parties automatically. If the national vote for any specified party is 
forecast to increase, then candidates will be added automatically for it in GB seats where it did not 
previously have any. Any party that increases its vote by a specified percentage can also be automatically 
added. If the “check candidates list” first option is set then a party will only be added if a named candidate 
exists in that constituency (in the list of candidates for the next election). 

 Add Others Automatically – if the forecast vote total in a seat (after all other adjustments) is less than the 
target total (e.g. less than last time) then an “others” vote will be created which will bring the total votes up 
to the target level. Here “others” means “other votes” for indeterminate parties. 

 Assume Candidates List is Final – this option will override the other automatic adding of parties options 
above. It basically will add a party during forecasting if a named candidate exists for it (in the candidates 
list)  and the party doesn’t already exist. It will also remove parties which do not have a nominated candidate 
in a constituency for which a valid candidates list exists, and will redistribute that parties originally forecast 
votes according to a simple application of the party vote transfer preferences (e.g. if PartyA has the vote 
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transfer to PartyB set to 40% then 40% of the PartyA votes would be transferred to PartyB in a constituency 
where PartyA was eliminated and PartyB remained). Any votes not specifically transferred to any other 
party will be redistributed in accordance with overall constituency vote preferences.  

 Enable constituency pacts between parties – if  this is set to enabled, and the candidates list for a 
constituency shows that one party has stood down its candidate in order to support another party, then 
forecasting will take account of this. (See the section on adding results for details of how to specify party 
pacts – basically the gaining party is specified as the candidate name preceeded by an ‘>’ symbol.)  

 Add Negative Others Automatically – this option is typically used with UNS forecasting in situations 
where the vote in a constituency may increase compared to the past election – consider, for example, a case 
where there is only one of the parties for which poll percentages have been added in a constituency, and that 
party is forecast to increase by 5%. Unless all the votes are scaled proportionally (see the auto correct 
change in constituency vote option) or the other parties are added (and given negative votes) then the new 
total votes for the constituency will be too large – and if all the parties are scaled proportionally to correct 
the constituency vote total then the gaining party will no longer gain 5% as its total vote will be reduced 
proportionally. If this option is set then in the case given “ Others” will be added, and given a negative vote 
of 5%, and the displayed percentages for the other parties will look correct, although in fact it will make no 
difference to which party is forecast to win the seat. 

 Auto-Correct Change In Constituency Vote Total – if set, this is applied after the other processing options 
have been processed. In each constituency UK-Elect will do a simple comparison between the total number 
of votes forecast and the total number of votes that there should be, and will adjust the total to the correct 
amount by multiplying all the votes by the correct ratio. This option is particularly important with the 
Proportional method, as otherwise the forecast number of votes in each constituency would vary 
enormously! 

 Forecast Overwrite Settings– these control whether an existing forecast for a constituency is overwritten 
when a new forecast occurs. If the “overwrite forecast results with known new results” is set, then any new 
forecast will not overwrite constituencies where the results are already known. If the “Reset constituencies 
outside forecast area” is set, then those constituencies will be reset to their previous election results, 
otherwise they will be left unchanged (e.g. as set by a previous forecast – this enables a series of individual 
regional forecasts to be made). If the “include constituencies that are selected in totals, but do not overwrite” 
is set, then those constituencies will not be overwritten but will be included in forecast calculations – this 
can be used to protect the forecast results for particular constituencies, or to do a national forecast after pre-
forecasting one or more individual regions. Constituencies are selected via the Selections option on the Edit 
menu.) 

 Turnout – turnout can be allowed to vary, set to the same as previously, to a particular percentage, or to a 
calculated value based on new results so far (e.g. on an election night). The default setting is “allow to vary” 
which means that the turnout percentage for any individual constituency can be allowed to change as a result 
of the forecast calculations (usually the change is by a relatively small amount) depending on the other 
forecasting configuration settings – e.g blending results with by-elections and constituency opinion polls can 
affect the forecast turnout. Note that turnout adjustments are made by multiplying all of the forecast votes 
for a constituency by a correcting proportion to achieve the correct vote total. 

 Additional Forecast Notes / Diagnostics Display – this option can be used to display additional notes 
about how a  forecast was made for each constituency, for example whether  incumbency criteria was used 
for a particular constituency, or the effects of tactical voting. If enabled, the information is found below each 
constituency forecast on the constituency view. 

 
 

3.4. Custom Forecasting Configuration 

 
Selection of the Custom… option will display the custom forecasting dialog, which provides a 
high degree of flexibility when configuring election forecasting: 
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 UNS Weighting - whether to use a Uniform Swing (add or decrease a parties votes by the same amount in every 

constituency), or a proportional method (multiply a parties votes in each constituency in proportion to its national 
vote increase or decrease), or a combination of the two. The weighting for increase and decreases can be 
specified individually. Note that the UNS percentage is specified, but that the proportional percentage is always 
(100% - UNS percentage). 

 Do decreases first, redistribute losses to gainers – whether to calculate the total in each seat for the parties 
losing votes first, and then redistribute those votes lost to the parties gaining votes in that constituency. The 
alternative is to treat the two calculations as independent, which may mean that the number of votes lost and 
gained will be different (although this can be corrected by several of the other forecasting parameters on the main 
forecasting menu, such as the “auto-correct change in constituency vote total” option, or the “automatically add 
others” and “automatically add negative others” options. 

 Smaller party / loyalty / localised strength / incumbency method selection  – Historically proportional 
methods have proved to be very poor at forecasting the number of seats won by minor parties when their national 
vote is projected to decline. Using a strong/weak vote threshold (as used by the “Proportional Loss With 
Threshold” method), or more general localized strength settings provide a means to fine-tune the forecasting in 
this situation.  Although UNS copes better with that situation, the Smaller party / loyalty / localized strength / 
incumbency settings can be useful when in a situation where it is expected that winners from small parties will 
hold onto their seats extremely well even when their national party vote declines very considerably. 

 Smaller party / loyalty / localised strength / incumbency settings – The settings define the number of voters 
“loyal” to the incumbent party. These voters are excluded from any vote losses – e.g. if the calculated percentage 
is 25% for a particular party, then previous winners from that party will have their vote loss reduced by 25%. 
Note that in order to achieve the target percentages for that party, vote losses elsewhere (in seats they didn’t win 
previously) will be increased to the extent necessary to balance the reduced vote losses. These setting can be 
used to generally protect the votes of incumbent parties, and the degree of protection can vary according to the 
number of winners (MPs etc.) that party has within the forecast area. This can make sense because it is often the 
case, for example, that individual MPs from smaller parties do better at combating a general vote decline for their 
party than individual MPs from larger parties, perhaps because they are more well-known. Note that the 
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calculated proportions are for the forecast area, which is not always UK or GB, so that, for example, the 
Conservatives are treated as a minor party when forecasting Scotland. See Appendix A for more details of 
election forecasting methods. 

 
As well as these settings there are buttons, which, if pressed, will set the custom settings to those 
values used by the named forecasting methods – e.g. pressing the “UNS” button will configure 
the settings to those used by UNS. (In fact, doing a custom forecast using UNS settings is the 
same as doing a UNS forecast.) The “Experimental” button represents an additional forecasting 
method currently being investigated, but the settings made by this are likely to vary considerably 
between versions of UK-Elect. 
  
Selection of the Advanced…  button will bring up the advanced forecasting menu 
 

 
 Results To Percentages Method - whether to use actual percentages, or to use the change since the last 

comparable result (either as a ratio or a swing) to calculate what the results percentages really mean. This is 
used when forecasting on the basis of by-election or early general-election night results 

 Seat Win Probability Calculation - This is used to set the parameters used to control the Curtice / Firth 
statistical algorithm used to calculate seat win probabilities. As a general rule a higher value for the Sigma 
parameter indicates a lower confidence in the accuracy of the opinion poll data source and/or forecasting 
mechanism. The BBC used a value of 4 in 2005 when calculating seat win statistics based on their (very 
large) exit poll data. For more details see the detailed election forecasting discussion on the UK-Elect  

 Election Date Target Percentages Adjustment Calculation Method - This option affects the target 
percentages actually used to make a forecast. It blends the current opinion poll percentages with the 
percentages achieved by the parties at the previous election, depending on how long it is until the next 
election (provided that the next election date is known). This reflects the fact that party support often returns 
closer to the level at the previous election during the run-up to a new election. 
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3.5. Tactical Voting and allowing for Incumbency 
 
Selection of the Tactical / Incumbency… option will display the Tactical Voting and 
Incumbency Configuration dialog: 
 

 
 

 Tactical Voting Configuration - specifies which parties are voted tactically against, and the circumstances 
when tactical voting occurs - i.e. how small the majority (of the party voted against) must be, and how big 
the gap between the second and third parties must be (the second party will gain votes from subsequent 
parties), and whether to apply when the party voted against is 2nd  and/or 3rd  and/or 4th. In addition vote 
transfer preferences can be taken into account. This works as follows: if the tactical voting contest is 
between PartyA and PartyB, and 100 votes would otherwise be redistributed from PartyC to PartyA for 
tactical reasons, and the relative support of PartyA and PartyB is defined in the vote transfer percentages for 
PartyC as 10% for PartyA and 40% for PartyB, then 20 votes would go to PartyA and 80 votes to PartyC. 

 Incumbency Configuration – specifies whether an extra percentage should be added to the forecast 
percentage for the party/candidate that previously won the seat. Different percentages can be where a winner 
stands again, or stands down, or a percentage can simply be applied to the party total irrespective of whether 
the previous winner is standing again. If it is not known whether or not the previous winner is standing 
again, or if the “only when first time winner” option is checked and the winner has won more than once 
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before (i.e.is not defending a newly won seat) then these party percentages will also be used. (The “only 
when first time winner) option is available. and defaults to on, because some academic studies have 
suggested that the incumbency advantage is greater in the case of first-time winners.) Note that in order to 
allow for the increase in the party votes in the constituencies where it is the incumbent, the total for that 
party will be proportionally reduced in all seats, and then the incumbency advantage added back in where 
appropriate. This is to keep the forecast vote totals correct. 
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3.6. Setting the Electoral System 
UK-Elect can forecast what the result of an election would be if fought under the same, or a 
different, electoral system. To set the electoral system choose an option from the Electoral System 
submenu on the Forecast menu. (For more details of electoral systems see Appendix C.)  
 
Electoral systems can be configured using the Forecasting Electoral System Settings dialog: 

 
 

 Forecasting Electoral System – which electoral system to use. Note that “default for current election” 
means that the default settings for the currently loaded election will be used (e.g. FPTP for the House of 
Commons or AMS for the Scottish Parliament). 
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 Additional Member Configuration – “Default” indicates use the default seat-number settings for the 
currently loaded election file.  If  “Number of seats for each AMS region” is selected then the specified 
number will be used for every region. If “Total number of AMS seats” is selected, then the specified 
number will be divided between the regions in proportion to the number of constituency seats in each 
region. If “Ignore constituency seats won when calculating AMS winners” is set, then no allowance will 
be made for how many constituency seats each party has won when calculating regional seat winners – 
normally this option is turned off, as the regional seats are intended to correct any imbalance in the 
constituency seats. If “Allow area seat allocation to Others” is checked then “Others” will be treated as 
one party for AMS area seat allocation purposes – this is normally not correct, so the option is 
unchecked by default. When  “Use AMS Regional Poll Percentages for forecasting AMS regions is set” 
then the separate AMS regional poll percentages will be used for this purpose, rather than the main 
forecast percentages. The “Minimum vote percentage required to win AMS seat” represents the 
threshold below which a party is not entitled to win any regional seats even if otherwise entitled to do so 
– large parties tend to use this to exclude smaller ones in circumstances where there are many seats per 
region. 

 
 Party List Configuration – the settings for Party List are a subset of those used for AMS – see the 

description for Additional Member Configuration for details of how to set these options 
 

 Alternative Vote Configuration – if “Continue counts until 2 Party Preference established” is set, then 
counting and vote-redistribution will continue until only two parties are left. The alternative is “Stop 
counts when winner established”. Note that these options don’t affect which party wins, just the display 
of the final situation. 

 
 Two Round Configuration – “Maximum second round finalists” controls the number of finalists. In 

some two-round systems this number is set to 2 – i.e. the final round is between the two leading 
candidates. Alternatively (or as well) the “Minimum percentage to qualify for second round” option can 
be used. Only candidates with this vote percentage, or above, will be eligible to take part in the second 
round of voting, which is held on a first-past-the-post basis. 

 
 Single Transferable Vote Configuration – “Optimize number of candidates for each party” will 

automatically add or delete candidates if it might advantage a party to do so – e.g. if a party has a high 
percentage of the vote but only one candidate in a multi-seat constituency then one or more additional 
candidates (called “A.N.Other xxx”) will be created, whereas if the party has a low percentage and 
several candidates then one of them will be removed. The calculation is based on the initial projected 
vote totals (before transfers and other adjustments) therefore does not always result in an extra seat 
being won, but setting this option can make a significant difference to overall results. “Optimize 
Aggressively” uses a slightly different algorithm that creates more extra candidates, although these 
additional candidates often do not win any extra seats for a party and can lead to seats being won at a 
later counting stage than would otherwise be the case. “Minimum seats per STV constituency” ensures 
that each STV constituency has at least the specified number of seats.  If converting to STV from some 
other electoral system it is recommended that this number is set to at least 2, and that the “Optimize 
number of candidates” option is turned on. 

 
 Vote Transfer Configuration  – This is used for controlling  the Alternative Vote (AV), Single 

Transferable Vote (STV), Supplementary Vote (SV) and Two-Round vote transfer that happens at the 
end of each stage (e.g. when a candidate is eliminated).  If “Use Party Vote Preferences” is set, then the 
individual party vote transfer preferences will be used (see section 6.9). If “Ignore” is set then no votes 
will be transferred.  If “Transfer votes using same proportion as constituency first preferences” is set 
then votes will be transferred in proportion to the 1st preference votes.  The amount of votes transferred 
can be reduced by setting the “percentage to transfer at each stage” to less than 100% - this simulates 
people who do not put additional preferences on their ballot paper (the UK-Elect transfer default is 
90%).  Note: if there are any candidates of the same party as that from which the vote originates to 
whom votes could be transferred, then that transfer will take priority. Also, where two or more 
candidates from the same party are eligible to receive transferred votes, the transferred votes they 
receive will be proportional to the ratio between their relative 1st preference votes. 
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In addition to the various configuration options described previously, buttons can be used to set 
the configuration to that used in various electoral systems around the world – e.g. to the 
Alternative Vote system used in the Australian House of Representatives. 

3.7. Performing the forecast 
The forecast using the selected percentages and forecasting method will be performed on 
selection of the Forecast, Opinion Poll Based Forecast or Swing Based Forecast menu options. 
The Forecast option uses target percentages (see above), whereas the Opinion Poll Based Forecast 
uses unadjusted opinion poll percentages. The Swing Based Forecast allows the user to enter a 
figure for the swing between any two parties - other forecasting configuration can optionally be 
applied. Any open windows will be updated to show the forecast results. The results can then be 
reviewed in the future by selecting the Forecast Results option from the Election Results combo 
box. 
 
Note: When forecasting using the Single Transferable Vote, Alternative Vote and Two 
Round systems the Vote Transfer Preferences should also be configured (see section 6.9). 
Because these preferences affect the forecast results, it is possible to get a range of different 
outcomes for the same opinion poll percentages – even if percentages corresponding to those that 
actually occurred at the previous election are used! 
 

3.8. Converting a previous election to a different Electoral System 
To convert a previous election to a different electoral system configure the electoral system, and 
then select the “Convert Base Election Results” option on the Forecast / Electoral System sub-
menu. Note that the base election can be set via either the forecast configuration dialog or the 
opinion poll percentages dialog, and that it is usually important to consider (and possibly edit)  the 
party vote transfer preferences (see section 6.9)  in order to achieve a realistic result. 
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3.9. Matching Seats 
A reverse forecast can be performed via the Forecast/Match Seats… menu option. A reverse 
forecast will calculate the party vote percentages required to achieve a particular result. It is 
possible to specify a degree of acceptable inaccuracy, i.e. an error margin of 5 linked to a required 
target of 300, would stop calculating when a total between 295 and 305 was achieved. 
 

 
 
Options on the Match Seats dialog are: 
 Target - specifies the name of the party and the required number of seats (or counties or regions) to be won. 
 Control - specifies the degree of acceptable variation and the maximum number of iterations (progressively 
refined attempts) to calculate the percentage required to achieve the specified total seats (or counties or regions). 
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4. Viewing / Analysing election results and forecasts 

4.1. Opening an Election File 
UK-Elect election files (*.eln) can be opened via the File \ Browse… or File \ Open… menu 
commands. 
 

4.2. Viewing and Analysing Elections 
 
Data associated with an election can be viewed in a number of ways using three types of display 
window:- the Summary Window, the Detailed Results Window and the Map Window. Access to 
all three windows is via icons on the control bar or the View \ New menu option. 
 
All three types of window interact. If a constituency is selected by clicking on a map, for 
example, then it will automatically be highlighted in the Summary and Detailed Results windows.  
 
=> To change the results being viewed 

 From the results combo box, choose an alternative set of results. 

 results combo box 

The three display windows will update to show the newly selected results. 
 
=> To change the position being viewed 

 From the position combo box, choose an alternative position to view. 

 position combo box 

The three display windows will update to show the results associated with the newly selected 
position (e.g. constituencies on maps will be coloured accordingly). 
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4.3. Searching for Candidates, Constituencies etc. 
 
=> To locate a constituency or a candidate 

 From the Edit menu, choose Find. 
 

The Find dialog will be displayed. 

 
 
 Find What - specifies text to search for. 
 Search - specifies the search area. 
 Also search.. – if this option is set then previous and future results for the constituencies displayed will also 

be searched (e.g. the results for those constituencies in any previous election) 
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4.4. Filtering Constituencies 
 
Filtering can be used to show, for example, constituencies gained by Labour in Scotland in 2010, 
or constituencies where the sitting MP was defeated in 2005. 
 
=> To filter 

 From the View menu, choose Filtering. 
 
The Filtering of Results dialog will be displayed. 


 
 Election Criteria – specifies which election(s) the filter criteria conditions on this dialog will be 

applied to. This controls not only which constituencies are displayed but also potentially affects the 
results of overall swings etc. when displayed in the overall results summary. “All” means that the filter 
conditions are applied to the currently displayed election (and if the election displayed changes the tests 
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will be applied to the new one) and the conditions are applied dynamically to any other elections 
referred to – e.g. in the constituency results view where overall results summaries also show the 
summaries for previous elections. As an example, if this setting is used, and the criteria is set to 
“gains”, then the first swing shown in the overall results view will be between the constituencies where 
gains occurred at the current election, and those where gains occurred at the previous election. 
Potentially, these are not the same constituencies. By contrast, if the criteria is set to “currently 
displayed” then the tests are always made for the currently displayed election, so the same 
constituencies will be compared in the results view history (unless boundaries have changed, in which 
case the most similar ones will be compared if the “use closes match when boundaries change” settings 
is applied). If the option is set to “specific” then the criteria is always applied to the election specified. 
This is useful to, for example, display what previously happened in those constituencies where gains 
occurred in 2010. 

 Gain Criteria - specifies whether to show only seat wins/gains/holds/losses generally or for a particular 
party. The option ‘All’ means is used to show all seats gained, held OR lost by the specified 
party,whereas ‘Changes’ displays just seats gained or lost (not held).’Not won’ display all seats not won 
by that party. 

 Area Criteria - specifies whether to show results for a particular area. An area is typically a local 
council area (e.g. a London Borough), but not all election files include area definitions. 

 Regional Criteria - specifies whether to only show results for a particular region / county or district. 
The Constituency Type field can be used to filter for Borough (mostly urban) or County (mostly rural) 
constituencies. 

 Majority Criteria - specifies whether to only show results where the winning majority conforms to 
chosen criteria such as being increased by a certain amount. 

 Swing Criteria - specifies whether to only show results where the swing is more/less than a specified 
amount 

 Relative Party Vote Criteria - specifies whether to only show results where the vote for a specified 
party (or any party) is more than the specified percentage of the vote of another party (or any party). 
Note that if both party selections are set to “any party” then no filtering will be done! 

 Vote Criteria - specifies whether to only show results where the vote for a party is (or changes by) 
more/less than a certain amount. Can also be used to filter by turnout. 

 Incumbency Criteria - specifies whether to only show results where the previous winning candidate 
stands again, or stands down, or is re-elected, or is defeated, or where the current winner was previously 
a candidate. The option to, if necessary, check two previous elections is useful in the common situation 
where boundary changes have occurred and estimates are provided for what the result in a seat might 
have been as these estimates are usually party-based and often do not include candidates. This 
Incumbency Criteria option is used to, for example, check the (usually small) difference in swings 
between seats where MPs stand down and stand again. Note: the candidate initial and surname is used 
for the incumbency checking test, if these are entered inconsistently then a candidate standing again 
may be missed. To correct this adjust one of the names and save the election file. 

 Skip by-elections - specifies whether to ignore by-elections when comparing the current situation with 
a previous result (e.g. to decide if seat gained) 

 Include Only - specifies whether to show only constituencies currently selected (using the selection 
options on the Edit menu), and/or whether to show only estimated/notional results 

 Reverse All – Reverses the effect of all the filter settings 
 Exclude Hidden – Excludes any constituencies that have been hidden 
 ID More Than / ID Less Than – only constituencies with IDs within the specified range will be 

displayed 
 Apply filter when calculating sums – specifies whether filtered-out constituencies should be included 

in calculations 
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=> To filter by Party Position 
 From the main filter dialog, or the View menu, choose Filter by Position. 
 
The Filter by Party Positions dialog will be displayed. 
 

 
 
 Party Position Criteria – allows filtering by the position of a party in a specified election 

 
Hint: When selecting the party name there may be a large number of parties in the drop-down 
combo box. For faster selection, simply click on the combo box and then start typing the party 
name, e.g. type “c” then “o” then “n” in quick succession, then use the enter key when the 
desired party is highlighted. 
 
=> To filter by Boundary Change Amount 

 From the main filter dialog, press the Boundary Change button. 
 
The Filter by Boundary Change Criteria dialog will be displayed. 
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 Boundary Change Criteria - specifies whether to display all constituencies, constituencies which are 

unchanged, constituencies which have had their boundaries changed, or constituencies that have changed by the 
specified percentage. 

 
Note: The boundary change percentage is calculated as follows: 

100.0 – ((TransferredVotes/ TotalVotes) * 100.0) 
where: 
TransferredVotes – the largest block of votes transferred from any old constituency to the new 
one 
TotalVotes – calculated as (NewConTotal – TransferredVotes + OldConTotal) 
NewConTotal – Total votes transferred to the new constituency (from all old constituencies) 
OldConTotal – Total votes transferred from the old constituency associated with 
TransferredVotes (to all new constituencies) 
 
This calculation aims to take account of the level of continuity between the new constituency and 
the old constituency which is most closely associated with it. In effect the calculated figure 
represents the percentage of total electors in either the old constituency OR the new one (or both) 
that are NOT part of the new constituency. If there is no change then this figure will be 0.0. The 
maximum likely change percentage will be around 66.0, which could occur if a new constituency 
is made up of around half of each of two old constituencies (i.e. only around one third of the total 
electors who are in the new constituency, or were in the old constituency, were/are in both!) 
The reason for the slightly complicated nature of the calculation is to take account of situations 
such as those where an old constituency is 100% absorbed into a new one, along with other 
voters, AND situations such as those where part of an old constituency forms 100% of a new one.
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4.4.1. Sorting Constituencies 
 
Constituencies can be sorted by a wide range of different criteria. Note that, in addition to the 
method specificied here, it is also possible to sort by clicking on any displayed column header – 
e.g. on the main 6-way summary window or on the detailed result view. 
 
=> To sort the contents of a window 

 From the View menu, choose Sort. 

 
The Sort Settings dialog will be displayed. 

 Primary Sort Criteria - specifies what the initial sort will be based on, e.g. alphabetically by constituency, 
or according to criteria such as majority, swing, votes, turnout, winnability (likelihood of winning) and best 
prospects for gains, in either ascending or descending order 

 Secondary Sort Criteria - specifies the criteria for sorting the results of the primary sort in cases where the 
sort comparison was equal. 

 Constituency / Area / County / Region Priority Sort Criteria - specifies whether to sort constituencies 
first, or regions first, or to only use the primary and secondary sort criteria. 

 

4.5. Choosing whether to display Constituency, Regional, and Area Summaries  

 
=> To choose whether to display constituency, area and regional summary information 

 From the View menu, choose Statistics Display - the Statistical Display Settings dialog 
will be displayed: 
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 Display - specifies what should be displayed out of overall summary, constituencies, areas, counties, regions 

and totals. 
 Summarise Regions/Counties/Totals as - specifies whether regions/counties and overall sums and/or 

averages should be displayed for votes and/or seats (if a council summary is loaded, then the choice is 
between seats and councils). 

4.6. Controlling colouring of Maps and Graphics 

 
=> To control how constituencies and graphics are coloured 

 From the View menu, choose Maps / Graphics Colouring Criteria 
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Available colouring criteria options include 

 Party Colours – constituencies are coloured according to common party colours 
 Alternate Standard Party Colours – constituencies are coloured according to an alternate “standard” set of 

party colours, used by some organizations from 2014 onwards 
 Percentage Lead – constituencies are coloured according to a mix of standard party colours and grey – the 

lower the percentage lead, the more grey (the effect is to dim the colours for a low percentage lead, and 
brighten them for a bigger lead). 

 Absolute Percentage  - as with percentage lead, but total percentage is used 
 Relative Percentage  - as with percentage lead, but coloured according to the margin between the two 

specified parties (taking no account of other parties) 
 Percentage Increase - as with percentage lead, but percentage increase is used 
 Percentage Decrease  - as with percentage lead, but percentage decrease is used 
 Percentage Change  - as with percentage lead, but percentage change is used, with grey representing a large 

decrease and full party colour representing a large increase (i.e. neutral would be represented by halfway 
between grey and the party colour) 
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 “Swing To” Percentage  - as with percentage increase, but the most “significant” swing to a party will be 
shown (this is not always the same as the biggest swing between any two parties, usually it is the swing 
between the first two parties, or between a previous winner and the new winner). 

 “Swing From” Percentage  - as with “Swing To” Percentage, but the most “significant” swing away from a 
party will be displayed. 

 Mix Party Colours – the party colours of the specified number of parties (e.g. the top 2) will be mixed, 
either using standard colours or proportionate to the party’s vote percent. This can be a very good way of 
showing “at a glance” the overall pattern of rivalries for a region or for the whole U.K. 

 Turnout – coloured proportional to turnout, the lower the turnout, the more grey 
 Turnout Increase – coloured proportional to turnout increase, the lower the turnout, the more grey 
 Turnout Descrease – coloured proportional to turnout decrease, the lower the turnout, the more grey 
 Electorate – coloured proportional to electorate, the lower the turnout, the more grey 
 Party Colours (Previous Result) – same as for Party Colours, but applied to the previous election (e.g. it 

will show the colour of the party that was in the same position in the constituency result before the currently 
displayed / filtered election) 

 Brexit Referendum Leave Vs Remain (Estimated) – will colour constituencies according to known and 
estimated remain and leave percentages (e.g. showing as blue where strongly leave, and orange where 
strongly remain). The colours are shaded according to the size of the wiining percentage. 

 Brexit Referendum Leave % (Estimated) – coloured proportional to known / estimated Brexit leave vote 
percentage 

 Brexit Referendum Remain % (Estimated) – coloured proportional to known / estimated Brexit remain 
vote percentage 
 

For many options, a political party can be specified using the second (and sometimes the 
third) combo box. When this is set to “Any Party” then the current position will usually be 
used to determine which party colours are used. 

The final colouring criteria combo-boxes can be used to brighten (or dim) the colouring, and 
to specify whether party colours should be used or shades of a specific colour, An example of 
use of the colour contrast combo is when displaying the absolute percentages for a minor 
party, which would tend to look very grey – in this case it can be set to “Increase Colour x10”. 
An example of a case where it makes sense to use a specific colour for shading, rather than 
party colours, is when turnout is being displayed. 

Map Display Settings are used where constituency boundaries have changed, and the map 
being displayed does not match the current election (i.e. the boundaries did not apply to that 
election). In this case the user can choose whether to not colour the constituency, or to colour 
it as if were the closest matching constituency, or to only colour it as if it were the closest 
matching constituency if that constiuency is a good match (most of it remains the same). 

Summary Box Settings can be used to configure the colours used in the summary box that 
appears on maps and graphics and which shows,for example, the number of seats won by each 
party. The background colour, and text colours used in the summary box can optionally be 
specified. (If they are not specified then the map defaults will be used, normally light grey for 
the background and black for the text.) In addition party colours can be used for the party 
names or, alternatively, for the background area behind each party name.  

Party Colour Display Settings can be used to override the default (but user configurable) 
colours used by UK-Elect, replacing them with “standard” colours, which are fairly often used 
on maps by media organisations. The party colours recommended for use on Wikipedia, in 
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particular, are increasingly commonly seen. Some of these “standard” colours (e.g. 
yellow/gold for the SNP) do tend to make map display less clear, however, when combined 
with the more advanced UK-Elect colouring criteria options described above, which is why 
UK-Elect does not currently use them by default. 

 

4.7. Map Marker Symbol Display  
 
 
=>To control how map marker symbols are displayed 

 From the View menu, choose Map Marker Symbol Criteria. The Map Marker Symbol 
Criteria dialog will be displayed. 

 

Available map marker symbol criteria options include 

 Marker Symbol Visibility – whether to force the symbols to be displayed, or stop them from being 
displayed, or leave to the default setting (which is to display them only when constituencies are not being 
recoloured, e.g. because the map is a place map rather than a constituency map). In addition an option is 
provided to hide the symbols if no information is available for that constituency according to the currently 
displayed filter settings (i.e. it would be displayed in light grey). 

 Marker Symbol Type – what symbol to draw, if symbols are displayed. Options include: 
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 Default – this may vary depending on map displayed. Often it is a summary piechart. 
 Filled diamond – simple diamond shape filled with the same colour as the underlying constituency 

(useful  when providing markers of constituency values on top of an ordinary place map) 
 Summary pie chart – shows vote (or seat, where a summary election is being displayed) total as a pie 

chart 
 Gain/Loss indicator – draws up or down triangles (or both) filled with the colour of the gaining and/or 

losing party 
 Percentage Bars -  displays either absolute or relative (percentage change) vote (or seat) percentages as 

a small bar chart drawn on top of each constituency.  The number of places drawn can be configured 
(e.g. if this was set to 2 then the top2 parties in each constituency would be displayed). The maximum 
number of previous elections displayed on the chart can also be displayed (normally 1, but can be set to 
a higher number so that absolute change percentages for the same parties for previous elections can also 
be displayed on the same graph. 

 Constituency name only – the constituency name will be displayed 
 Default – this may vary depending on map displayed. Often it is a summary piechart. 
 Marker Symbol Type –  options to control the size of the map symbol in pixels (at the native 

resolution of the map). This can be scaled by map size (meaning that the size will be increased for very 
large maps and reduced for small ones), and/or in proportion to the constituency votes size (so that a 
symbol for the Western Isles would appear smaller than one for the Isle of Wight, for example – note 
that this scaling is done by the actual number of votes cast). Compensation for zoom factor can also be 
applied (so that the symbol stays a similar size even as a map is zoomed in or out).  

 Marker Text Visiblity and  Background Transparency –  options to control whether the constituency 
name is displayed under the marker symbol, and whether the text is drawn with a transparent 
background. 

 
Example of map marker symbols: 
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4.8. The Summary Window  

A Summary Window can be opened by clicking on the    icon. The Summary Window as 
shown below is itself subdivided into four to six display areas (two of which are optional).                     
            

   
 
The Constituency area (top left) displays the results relating to the currently selected constituency 
in the Constituency Summary area. 
 
The Detailed Constituency List View (below the constituency area) displays a detailed list of all 
constituencies. The data displayed in the columns in this list is highly configurable, via the 
“Choose Columns” option on the View menu, sortable by clicking on columns headers, and in 
addition the list can be displayed in other formats (e.g. as icons) if desired. The columns can also 
be re-ordered in the view by clicking on them and dragging them to a new location. Multiple lines 
can be highlighted at the same time and copied to the clipboard in CSV format (suitable for 
import into spreadsheets such as Excel etc.) or saved using options on the File Export submenu. 
 
The Constituency Summary area (optionally displayed below the Detailed Constituency List 
View) displays a simple list of all constituencies together with the winning candidate and the 
party holding the currently selected display position.  
 
The Graphic Display area shows a pictorial representation of the results for the currently selected 
constituency, using standard charts such as bar charts, 3D bar charts, pie charts, and trend graphs. 
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The Map area displays a smaller version of the Map Window that presents a geographical 
representation of the area that includes the selected constituency. When the mouse cursor is over a 
constituency the constituency name will be displayed. 
 

 
 
The Web Browser area displays a resizable web browser control which can be used to 
dynamically display constituency, election and candidate information – or, in fact, any sort of 
information viewable on standard external websites. It can be set to be context-sensitive, 
automatically looking up and displaying information about the currently selected constituency 
from Wikipedia or from a selection of other websites, or from the user’s own preferred site. See 
the Web Browser configuration section for details of how to configure this functionality.  
 
Note Selection of the right mouse button in the Summary Window will display a floating menu. 
The options on the menu will vary according to the area of the Summary Window. 
 
Taken as a whole, the Summary window is highly configurable, with each individual sub-area 
also supporting many view and display options.  
 
 
=> To change the graphic display 

 From the graphic combo box, choose an alternative type of graphic. 
 

 graphic combo box 
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The pictorial representation of the results will update using the newly selected graphic. 
 
=> To change the map being displayed 

 From the map combo box, choose an alternative type of graphic. 
 

 map combo box 
 

The map area will update to display the newly selected map. 
 
=>To prevent the window from being automatically updated 

 Click on the Lock Summary Constituency icon.  

 Lock Summary Constituency 

-or- 
From the View menu, choose Lock Constituency. 

 
The Summary Window will not change as a result of a different constituency being selected in 
another window, for example the Map Window. 

 
=>To highlight the selected constituency when selected 

 Click on the Highlight Selected Constituency icon. 

 Highlight Selected Constituency 

The currently selected constituency on the map will be highlighted. Note: this option can be 
deselected by clicking again on the icon. 

 
=> To show/hide the summary box 

 Click on the Show or hide map summary box icon. 

 Show or hide map summary box  

The summary box will appear/disappear depending on the toggle state of the option. 
 
=> To blink constituencies where gains have occurred 

 Click on the Blink Gains icon. 

 Blink Gains 

Any constituencies where power has changed hands will blink in the Map Window 
 
=> To select the criteria used to colour maps and graphics 

 Click on the Colouring Criteria icon. 

 Colouring Criteria  

-or- 
From the View menu, choose Maps / Graphics Colouring Criteria (see section 4.1). 
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=> To change the font in the Summary Window 
 From the Options menu, choose Summary Result Font to change the Constituency 

Summary area font. 
 From the Options menu, choose Summary List Font to change the Constituency area font. 
 
The standard font selection dialog will be displayed. 
 

=> To copy a map to the clipboard  
 Click on the Copy Map icon. 

 Copy Map  

-or- 
From the Edit menu choose the Copy Map command. 
 
-or- 
From the Edit menu when the map window is active choose the Copy command. 
 

=> To save a map to an image file and start the associated program  
 Click on the Save Map and Start Associated Program icon. 

 Save Map and Start Associated Program  

-or- 
From the File menu choose the Export submenu and the Save Map and Start Associated 
Program command. Note: the currently supported image file formats include .png, .jpg and 
.bmp. The Export submenu also includes the option to save the map without starting the 
associated program. 
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4.9. Configuring the Web Browser Control  
The Web Browser Configuration Dialog is used to configure the text sent to the web browser 
whenever a new constituency is selected. Default settings are provided for connecting to some of 
the most common and useful websites such as Wikipedia and the BBC. Separate settings are 
provided for General Elections, Scottish Parliament and Welsh Assembly configuration. It is also 
possible to create text specific to the currently loaded election file that will only be used with it – 
this information will actually be stored in the election .eln file itself. 
 
The text used when looking up individual constituencies or elections (the text used when an 
overall summary is being displayed) can also be configured separately. Several special 
placeholder values are provided: [#YEAR] will be replaced by the year of the election currently 
being displayed,  [#ELECTION] by the election name, [#CONSTIT] by the constituency name, 
[#WINNER] by the winner’s name, and [#ID2] by the constituency ID2 field (typically used to 
hold the ONS/GSS code for the constituency, although it can be any text). The use of these can be 
demonstrated by choosing the google default settings and then observing the text created on the 
dialog, and that sent to the website. 
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. 
 

4.10. The Detailed Results Viewer/Importer/Exporter Window  

A Detailed Results Viewer / Importer / Exporter can be opened by clicking on the    icon. 
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The window displays a complete list of data associated with the currently selected election (e.g. 
results and/or constituency information), sorted according to the current sort order. Alternatively, 
clicking on a column will sort by the order in that column. Click on the column again to toggle 
between ascending and descending order. Icons at the left of each item show the emblem of the 
party corresponding to the currently selected result position. 
Note: selection of the right mouse button in the Detailed Results Window will display a floating 
menu.  
 
=> To import data (e.g. results) from a comma-separated values (csv) text file  

 Click on the Import Results icon. 

Import Results is the leftmost icon on the Detailed Results Window toolbar 

A dialog requesting the import file will be displayed (note: if you are viewing certain election 
files, e.g. an election forecast, then you may first be asked for confirmation that you wish to 
import new election results). After a file has been selected then the Import Settings dialog will 
be displayed. This allows you to configure how you wish the data to be imported. All 
imported data should be one constituency per line, and with party totals in a separate (comma-
separated) column for each party. The first line always represents column titles, not data 
values. 
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The "Recognise Constituency By" section allows you to specify whether UK-Elect should try 
and identify each imported constituency by the Line Number (i.e. the first line will be 
assumed to be constituency ID 1, and could overwrite the first constituency in the election 
file); by Constituency Name (i.e. UK-Elect will try and recognise the Constituency by its 
name - please note that for imported constituency names to be correctly recognised they 
should be consistent with those already defined in UK-Elect), otherwise new constituencies 
differing slightly in name may be created; or by Constituency ID or Constituency ID2. 
(Constituency ID2 can be any text identifier but is commonly a statistical or geographical 
code such as an ONS/GSS identifier). Constituency name matching can optionally be set to 
match in reverse order – which will recognize newer (boundary changed) versions of 
constituencies in preference to the older (original) versions where both exist. 
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UK-Elect can be configured to import all the data from the file overwriting any constituencies 
of the same name or ID (and adding those that don't already exist); to import all data adding 
into existing constituencies (this option is usually only used when adding in extra candidate 
names for a forthcoming election); to import all, leaving existing constituencies unchanged; to 
import all, after deleting all existing constituencies; to only import those constituencies which 
match the current filter settings; to only import those constituencies which are currently 
highlighted in the Detailed Results Viewer / Importer / Exporter window; and to import all 
adding in any new constituencies, and any new parties in existing constituencies, but simply 
overwriting any votes found in existing constituencies for existing parties. This last option 
could be used to, for example, change only Labour and Conservative votes without affecting 
the values for other parties. 
 
UK-Elect can also be set to use the imported party names (from the first line of the imported 
file), and to import more parties than can actually be displayed in the Detailed Results Viewer 
/ Importer / Exporter window. To do this, simply type the additional number into the "Number 
of additional party columns when importing" box. 
 
The import field separators can also be configured. Normally they are set to at least commas, 
but when importing data that has been produced by non-English software it may be necessary 
to set the semi-colon tick-box and uncheck the comma. This is because many countries use 
commas as a decimal place separator, and their “comma-separated” files are semi-colon 
separated. 
 

=> To output the contents of the window to a text or comma-separated file 
 Click on the Output / Export all results icon. 

 Output all results 

A dialog requesting the output file will be displayed. The type can be set to text (*.txt) or 
comma-separated (*.csv). The contents of the Detailed Results Window will be sent to the 
designated file. 
 
There is also an “Output all results and invoke associated program” option, which differs only 
in that the program associated with the specified file extension (e.g. Microsoft Excel for .csv 
files) will be automatically invoked and passed the file name after the data is written. 
 
Note: Comma-separated files can be written or read by most database and spreadsheet 
programs (e.g. Microsoft Excel). 
 

 
=> To output the selected items of the window to a text or comma-separated file 

 Highlight the items you want to output. 
 Click on the Output selected results icon. 

 Output selected results  

-or- 
From the View menu, choose Output Results. 
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A dialog requesting the output file will be displayed. . The type can be set to text (*.txt) or 
comma-separated (*.csv). The selected items in the Detailed Results Window will be sent to 
the designated file. 
 
There is also an “Output selected results and invoke associated program” option, which differs 
only in that the program associated with the specified file extension (e.g. Microsoft Excel for 
.csv files) will be automatically invoked and passed the file name after the data is written. 

 
=> To prevent the window from being automatically updated 

 Click on the Prevent automatic update of results window icon.  

 Prevent automatic update of results window 

-or- 
From the View menu, choose Lock Results. 

 
The Detailed Results Window will not change as a result of a different constituency being 
selected in another window, for example the Map Window. 

 
=> To format the Detailed Results Window 

 Click on the Detailed Result Settings icon. 

 Detailed Result Settings 

-or- 
From the Options menu, choose Detailed Result Default Settings. 
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The Detailed Results Viewer Settings dialog will be displayed: 
 

 
 

 Title - allows the title of the window to be specified. 
 Columns - specifies which items will be displayed in the window. Options include position (line number), 

ID number (standard constituency ID),  ID2 (typically an ONS/GSS code but can be any text), region, 
county, districts/wards, Brexit information (estimated 2016 referendum leave vote percentage), area, 
electorate, turnout, total votes, invalid votes, winner (name of winning candidate), 1st party name, votes in 
vote order (e.g. show top 3 for each constituency, either in one column or using separate columns), votes in 
party order (e.g. one party per column – useful for exporting to spreadsheets or databases, and also allow 
quick sorting of votes for a party by clicking on relevant column), gain information (whether a gain or hold), 
gaiing party, losing party, majority, previous winner, previous winning party, incumbency information 
(whther the incumbent stood down etc.) swing , and seats (number of seats won, useful for summaries and 
multi-member constituencies). Votes for the parties can be displayed in columns as absolute votes and/or 
percentages and/or the change in votes and/or the change in vote percentages. Votes for ‘other’ parties can 
be displayed separately.  

 Other options –miscellaneous functionality, such as display vote percentages, show candidate names, set  
how to display unknown numbers, and whether to sum votes for the same party in multi-member seats. 

 
=> To change the font in the Detailed Results Window 



UK-Elect Page 49 
 

 From the Options menu, choose the Font option on the Detailed Results submenu. 
 

The standard font selection dialog will be displayed. 
 

=> To change how items are listed in the Detailed Results Window 
 Click on one of the view type icons. 

 Large icons/Small icons/List/Details 

These icons operate in the same way as in Windows Explorer. 
 

4.11. The Map Window  

A Map Window can be opened by clicking on the    icon. 
 
The Map Window can be used to display one of a large selection of maps representing various 
areas of the United Kingdom. It can also be used to display other types of election information 
such as Labour election targets. Constituencies and graphics can be coloured according to user-
selected criteria such as percentage lead (see section 4.1). 
 

 
 
Note: Selection of the right mouse button in the Map Window will display a floating menu.  
 
=> To change the map being displayed 

 From the map combo box, choose an alternative map to display. 
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 map combo box 

The Map Window will update to show the new map. 
Note: the map will change automatically if a constituency is changed in another Window and 
the Map Window is not locked. 

 
=> To zoom the map display 

 From the Zoom combo box, choose an alternative zoom factor. 
 
The map will be enlarged/reduced dependent upon the selected zoom factor. The “zoom to fit” 
option will allow the map to be rescaled by dragging the window border with the mouse. 

 
=> To prevent the window from being automatically updated 

 Click on the stop automatic update of map icon. 

 Stop  automatic update of map 

The Map Window will not change as a result of a different constituency being selected in 
another window, for example the Detailed Results Window. 

 
=> To show/hide the summary box 

 Click on the Summary Box icon. 

 Show or hide summary box  

-or- 
From the View menu, choose Show Summary Info. The summary box will appear/disappear 
depending on the toggle state of the option. 

 
 
=> To highlight the selected constituency when selected 

 Click on the Highlight Constituency icon. 

 Highlight Constituency 

-or- 
From the View menu, choose Highlight Selected Constituency. 
 
The currently selected constituency on the map will be highlighted. Note: this option can be 
deselected by clicking again on the icon. 
 

=> To display the original map without the constituencies coloured 
 Click on the Colour Constituencies icon (the one with the constituency coloured green) . 

 Colour Constituencies  

-or- 
From the View menu, choose Colour Map Constituencies. 
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The original map will be displayed - the constituencies will not be recoloured  according to 
the currently selected election, position, etc. 
 

 
=> To display the previous election results 

 Click on the Display Previous Results On Map icon. 

 Display Previous Results On Map 

-or- 
From the View menu, choose Display Previous Results. 
 
The Map window will be updated to show the results for the previous election. 

 
=> To display the next election results 

 Click on the Display Next Results On Map icon. 

 Display Next Results On Map 

-or- 
From the View menu, choose Display Next Results. 
 
The Map window will be updated to show the results for the next election. 

 
=> To blink constituencies where gains have occurred 

 Click on the Blink Gains icon. 

 Blink Gains 

-or- 

From the View menu, choose Blink Gains. 

Any constituencies where power has changed hands will blink in the Map Window. 
 

=> To select the criteria used to colour maps and graphics 
 Click on the Colouring Criteria icon. 

 Colouring Criteria  

-or- 
From the View menu, choose Maps / Graphics Colouring Criteria. A dialog will appear 
allowing selection of options such as colouring constituencies according to absolute party vote 
percentages. See section 4.1 for a discussion of this option. 
 

 To load an associated election file 
 Click on the Load Associated Election icon. 

 Load Associated Election  

. 



UK-Elect Page 52 
 

 To configure map marker symbols (gain/loss and vote change indicators  etc.) 
 
The Map Marker Symbol Criteria dialog is accessed by pressing the Marker Symbol button on 
the toolbar (a diamond symbol), or choosing the relevant option from the view menu. 
Basically, this option allows markers to be superimposed on constituencies displaying 
information such as which party gained the seat, which lost it, changes in party vote 
percentages, or a pie chart vote summary etc. See section 4.2 for a discussion of this topic. 
 

 
 

=> To copy a map to the clipboard  
 Click on the Copy Map icon. 

 Copy Map  

-or- 
From the Edit menu choose the Copy Map command. 
 
-or- 
From the Edit menu when the map window is active choose the Copy command. 
 

=> To save a map to an image file and start the associated program  
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 Click on the Save Map and Start Associated Program icon. 

 Save Map and Start Associated Program  

-or- 
From the File menu choose the Export submenu and the Save Map and Start Associated 
Program command. Note: the currently supported image file formats include .png, .jpg and 
.bmp. The Export submenu also includes the option to save the map without starting the 
associated program. 
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4.12. Comparing different elections, forecasts etc.  
The “User-Defined Comparison  Elections” functionality (accessed from the view menu or 
main toolbar) can be used to compare any two sets of  election results, highlighting the 
differences and changes between the results. 
 

 
 
Any set of results or forecasts (including by-election results and constituency opinion polls) can 
be copied into any of the three sets of user comparison election results and stored there for future 
use. (This can be handy when, for example, comparing different forecasts.) The copying can be 
filtered, so as to, for example, only copy results from a particular region, or those that match any 
other criteria (e.g. Conservative seats). Further sets of data can then be copied into the election 
(e.g. the results from a different region). It is also possible to manipulate the data in the user-
defined elections in simple ways, e.g. editing it, or even adding or subtracting a new set of 
election results to or from it, so as to highlight differences, or multiplying the results by a constant 
number. Any other election (including the other user defined elections) can be set as the preceding 
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election – i.e. the one that “swing from”, and “swing to” comparison calculations (and 
corresponding map display) are based on. 
 
The results in the user-defined elections can be treated like any other set of results as far as the 
usual display, forecasting etc. functionality is concerned, and can be saved and loaded, using the 
save and load buttons, or a display update forced by using the display button. The main Import / 
Export functionality can also be used to read / write the data to / from a specified file using CSV 
format (so that it can be manipulated  in Excel,for example). To use the main functionality select 
the relevant user defined configuration election (e.g. by using the Display button within the 
dialog, or by using the normal election selection  list), and then select  Import / Export (e.g. by 
using the option on the file menu). 
 

4.13. Display and General Settings  
The Display and General Settings dialog is accessed from the Options menu: 

 
 Automatically Calculate Total Votes – calculates vote totals (rather than using user specified values) 
 Exclude Invalid Votes From Turnout – if set, excludes invalid votes from turnout calculations 
 Backdrop – specifies whether to display a blank backdrop, a picture of the House of Commons, or a user 

specified file in Windows Bitmap format. 
 Display Settings – specifies whether to display separate subtotals for each party group when overall totals 

are displayed. (Note: this will only have any effect if the “Display as Party Groups”button is pressed.) The 
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default group can also optionally always be displayed last. “Display ID on Title Line” causes the UK-Elect 
ID to be displayed after the constituency name in the constituency details view. “Display BC/CC after 
Constit Name” causes BC (Borough/Burgh Constituency, i.e. mostly urban) or CC (County Constituency, 
i.e. mostly rural) to always be displayed after the constituency name (where relevant and known). 

 Tooltips Settings – specifies whether the winners name, the winning party/majority, and/or details of vote 
and winning-party changes should be displayed on the end of tooltips. Tooltips are the little popup windows 
that are displayed when the cursor is positioned over a constituency on a map. 

 Overall Summary Settings – specifies whether to display UK and/or GB percentages, and whether to 
display in summed seat, county, or region order (i.e. to display the party with the highest number of seats, 
counties or regions won first, rather than that with most votes won.) Can also be used to display seats won, 
or counties won, or regions won. The “Allow for Speaker voting with governing party when calculating 
majority” option is used when displaying majority information. The Speaker does not vote except in a tie, in 
which case the convention is for the Speaker to vote for the status quo, e.g. for the governing party in the 
event of a vote of confidence.  Therefore for the purposes of majority calculation the effective number of 
opposition MPs is reduced, and that of the governing party potentially increased, by one  – thus this option 
has the effect of increasing  a governing party’s majority by two if a Speaker exists (has been elected). 

 

4.14. Overall Appearance – Tabbed Views, etc.  
The overall appearance of UK-Elect can be adjusted by using the options on the View / 
Application look submenu. The available options correspond to the general appearance of many 
Microsoft products – e.g. Windows XP or Office 2007.  
 
UK-Elect also supports the use of tabbed views, something found in many modern programs – 
these can be enabled by using the “Tabbed Views” option on the view menu. 
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5. Using UK-Elect on Election Night 

5.1. Hints and Tips 
These hints and tips apply to a General Election but would be very similar for most other 
elections. 
 
Note: very important – practice these steps before election night! 
 
First, load the most up to date election file.  
 
Second, press the “Guided Forecast” button  (the button with the green triangle), and answer the 
questions that UK-Elect asks you.This will result in a forecast being done. If  you are happy that 
the forecasting is working in the way that you intended then leave the forecasting settings 
unchanged, otherwise repeat the process and answer one or more of the questions differently. 
  
Third (and only if you do intend to forecast based on actual election night results): 
 

- Make sure that the “source of forecasting percentages” setting on the forecast configuration 
dialog is set to “election-night”. (If the current date is on or very close to the election date then 
the UK-Elect Guided Forecast functionality will offer to set this option automatically for you.) 
 
- Try entering a new result by setting the election to “Latest Known Situation” and click on a 
constituency in the list, and then hit the insert key or use the right mouse button and select the 
add result option, and, if prompted, choose the “new election result ” option from the list of 
buttons. Now enter the new result (e.g. copy the old result and change the figures a bit to 
simulate a swing) and hit OK. 
 
- To easily see what percentages the forecast will be based on , choose the “target 
percentages” option from the forecast menu – this has the advantage that it will show the 
calculated percentages, and that “forecast”, “configure” and “opinion poll” buttons are 
available on the dialog, together with "recalculate", enabling changes to be made to the 
settings to see what effect it has on the calculated target percentages. 
 
- To actually do a forecast press the yellow forecast button. 
 

Now – practice entering a few more results and see what happens.  
 

Note: When exiting UK-Elect, do not save your newly entered results, unless it really is 
election night! 
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6. Adding / Modifying election results 

6.1. Creating a new set of election results 
Note: if you have a set of election results (e.g. for your local council) that you would like to be 
added to UK-Elect, then it is worth contacting support@ukelect.co.uk. It may be possible to 
include them in the next version, and provide you with a copy of the results in UK-Elect format. 
 

1. Create the Election File 
The simplest way of creating a new set of election results is to use the “New Election” option. 
This will ask a series of questions and bring up the appropriate dialogs to allow the creation and 
import of the new election data. It will prompt for details of map, graphics and results files that 
should be included. Results data should be in comma-separated form, with a column of data for 
each party and a line for each constituency. 
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An alternative is to copy an old election file and then edit the contents using a standard text-editor 
(e.g. copy HANTS93.ELN to ESSEX93.ELN). Using the file formats as given in Appendix C 
change the file appropriately. To create a Constituency Definition file copy an existing file such 
as HANTS93.DEF and again edit it using the file formats in Appendix C as a guide. After editing 
the election and constituencies files run UK-Elect and select “Open” from the File menu. The new 
election file should now appear in the list of elections that can be loaded. 
 
2. Define the Constituencies 
Constituencies can be added using the “Add Constituency” facility (see Section 6.2 for more 
details). 
 
3. Enter the results 
Use the “Add Result” facility to enter the results for the current, previous and old elections (see 
Sections 6.5 - 4.7). 
 
4. Add the Maps and Graphics 
You can change the election (.ELN) files to include the names of any maps and graphics. All of 
these are in Microsoft Windows Paintbrush (.BMP) or .JPG or .PNG  formats, so it is possible to 
design your own maps and graphics.  See Appendix C for details of file formats. 

6.2. Adding a new constituency 

 From the Edit menu, choose Add Constituency 
The Add/Edit Constituency Information dialog will be displayed. 

 
 Name - specifies the name of the new constituency. 
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 ID - specifies the internal identifier of the constituency (normally in the range 1 to 1499). 
 County - specifies the County that contains the new constituency. 
 Type – whether a (mostly urban) Borough/Burgh Constituency (BC) or a largely rural County Constituency 

(CC) 
 Region – Name of associated region 
 Area – Name of associated area (if any) 
 Council1 ..Council3 – Name of any associated district/unitary councils (optional) 
 Wards  -  Wards which constitute this constituency  (an optional comma-separated list) 
 Based on Constituencies – Used after boundary changes. Each line consists of a constituency name, an 

amount (usually in votes, although the value 1 is a special value that represents 100%), a calculated “total 
from” which represents the total amount of votes transferred from the specified base constituency, and an 
“original total” field which represents the original total electorate for the base constituency at the last 
election (if known, otherwise use 0). 

 Treat amounts as internal proportions  - If checked, then the amounts will be treated as internal 
proportions not transfer amounts i.e. if set to 85 for ConstituencyA and 15 for ConstituencyB then it will be 
assumed that 85% of the electorate for this constituency come from ConstituencyA and 15% from 
ConstituencyB 

 

6.3. Modifying a constituency 

 From the Edit menu, choose Modify Constituency 
 

The Edit Constituency Information dialog will be displayed (similar to the Add Constituency 
Information dialog). 

6.4. Deleting a constituency 

 From the Edit menu, choose Delete Constituency - a confirmation dialog will be displayed. 

6.5. Adding a new result 
 From the Edit menu, choose Add Result.  The Add Result dialog will be displayed. 
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Choose the type of election result to add and select the Next-> button to add the new result 
details using the dialog shown below: 

 
 Main result field – Each line usually consists of a name field, a party field, and a votes field. Each of 

the fields can be separated by a tab, or a comma, or two spaces. 
 Election – can be used to change the election name 
 Threshold % - used for some PR elections (e.g. London Assembly). Any party winning below this 

percentage is not eligible to receive AMS top-up or party list seats. Normally not used (and disabled). 
 Constituency - specifies the constituency for which the result is to be added. 
 Date - specifies the date of the election. 
 Estimate- (if visible) whether an actual result or an estimate 
 Change of Party – (if visible) specifies whether the election was the result of the change of party (e.g. 

defection, or election as speaker) of the current MP. 
 Electorate - specifies the number of people eligible to vote in the election. 
 No of Seats - specifies the number of seats to be won in the election. 
 Invalid Votes - specifies the number of invalid (e.g. spoilt) votes. 
 Associated Filename - the name of an election (.eln) file associated in some way with the result  
 Description – Description of the associated file, or, more generally, of the result 
 

The following options can also be useful when pasting in results obtained from web pages etc.: 
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 Display/Input Surname first – if set, surnames are displayed before the rest of the name  
 Remove Surplus capitals – converts upper case text into mixed-case 
 How to treat lines without numbers – useful when pasting in results from elsewhere that are split 

across more than one line. If set to “ignore” then lines not including any number are treated as 
comments; if set to “add to next” then such lines are added to start of next line; if set to “Add to prev” 
then such lines are added to the end of the preceding line. 

The Add Constituency option can be used to add a constituency that does not already exist in the database. 
The Browse Parties option will show a list of currently available parties in the database. 
When entering candidates for a future election the vote total is not required and can be set to 0. To indicate that a 
party is not standing a candidate itself, but supports another party (or candidate) that is standing specify the 
destination party name preceeded by a ‘>’ symbol. For example, >LD as the candidate name would indicate that the 
Liberal Democrat party is being supported, so >LD   PC  (>LD as the candidate name and PC as the party name) 
would indicate that Plaid Cymru is supporting the Liberal Democrat candidate in that constituency. 

6.6. Modifying a result 

 From the Edit menu, choose Edit Result 
 

The Edit Result dialog will be displayed which is similar to the Add Result dialog. 

6.7. Deleting a result 

 From the Edit menu, choose Delete Result 
 

A confirmation dialog will be displayed. 
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6.8. Adding/Modifying a Party or Party Group 

 To add or modify a party, choose Modify Parties from the Edit Menu 
 

The Add or Modify Party Information dialog will be displayed. 

 
 Name - specifies the name of the political party. 
 Full Name - specifies the full name of the party e.g. Conservative not Cons. 
 Abbreviated - specifies the abbreviation used for the party e.g. Cons. 
 I/O Name - specifies the name used when saving to, or reading from, UK-Elect data files. 
 Party Group - specifies an electoral alliance. Normally the Party Group is the same as the Party Name. 
 Description - specifies a full description of the party 
 Colour - specifies the colour to represent the party in UK-Elect graphics
 Leave Support- specifies the percentage of supporters of this party who support leaving the EU 
 Remain Support- specifies specifies the percentage of supporters of this party who support remaining in the 

EU
 
Note that the total of leave and remain values above must not exceed 100%, but can be 
significantly less where some supporters are undecided or not motivated by Brexit. If the level 
for a party is unknown or not significant then leave both values at zero. 


When modifying the data additional information will be displayed. 
 Aliases - specifies alternative names for the party (used when recognising party name during data entry). 
 Colour selection  - the colour can be changed by clicking on a Select button to display a palette from which 

a colour can be selected, or by typing in the red, green and blue component values (0 - 255). 
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To add or modify a Party Group, choose Modify Party Groups from the Edit Menu. Editing of 
Party Groups is done in exactly the same way as Parties. 
 

6.9. Vote Transfer Preferences 
It is also possible to set “Vote Transfer Preferences” by pressing the relevant button on the 
Modify Party dialog. The vote transfer preferences are used to determine how votes are 
redistributed when the Single Transferable Vote, Alternative Vote or Two Round electoral system 
is in use, and can also be used during tactical voting simulations.   
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The “Vote Transfer Preferences” dialog is shown and described below: 
 

 
 

 Ignore – votes for the current party are not transferred to any other. 
 Same proportion as constituency 1st preferences  - votes are redistributed in the same proportion as that 

between the not already eliminated parties in the constituency result (e.g. if the Conservatives and Liberal 
Democrats each won 40% of the constituency vote, and Labour were last with 20% and were eliminated, 
then 50% of their vote would go to each of the other two parties, which would each increase their total by 
10% of the original vote total). 

 Use specified percentages – directly specifies the percentage ratios to use. Please note that these are 
actually ratios and need not add up to 100%. What matters is the relative ratio between the parties – e.g. a 
party set to receive 50 “percent” will always receive twice the number of votes as one set to receive 25 
“percent” from the same party, but always provided that it has not already been eliminated (and that it stood 
in the constituency in the first place!) 

 Preferences for parties not shown above – is used to specify the votes received by all parties not directly 
specified (e.g. minor parties). 
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6.10. Updating after a new election (e.g. a General Election) is completed 
On a full election night (e.g. for a General Election) new results can be entered as they occur. This 
is useful for displaying the current situation, and forecasting based on the new results. However, 
after the election is complete it is necessary to update the election files so that future forecasts are 
based on the newly completed election. This is done by using the “Update After New Election” 
option on the Edit Menu 
. 

6.11. Boundary Changes 
UK-Elect provides considerable support for coping with the effects of boundary changes. One 
important feature is the Boundary Change Import dialog: 

 
 OldConstit ID Range – the range of constituency IDs used for “old” (pre-boundary change) 

constituencies 
 NewConstit ID Range – the range of constituency IDs used for “new” (post-boundary change) 

constituencies 
 Overwrite check-boxes – used to control whether existing boundary change information (including the 

names of new constituencies, and the BC/CC type) is overwritten 
 Auto-Accept constituency name matches – constituencies can be represented in the import files as 

names, rather than IDs. (In fact, this is normal where the original information was imported from some 
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external source.) In that case, if UK-Elect thinks it recognizes the constituency when it is reading an 
import file, but the name match is not exact, it will ask the user to confirm the match. If this option is 
set, it will simply assume that the match is OK. 

 Convert Upper case names to mixed – if set, UK-Elect will convert names that are entirely upper-case 
into ones with mixed case. (The results of this should, however, be checked carefully as some names , 
e.g. Scottish ones, may be mis-capitalised.) 

 No. of lines to ignore at start – the specified number of lines will be ignored 
 Column number to ignore – the specified field (spreadsheet column) will be skipped 
 Include district and ward names at start of each line – if checked, assumes first fields are district and 

ward names 
 File format – Choose from among the comma-separated file field ordering offered in this section. 

Where amounts are specified then these are used to create the boundary change constituency transfer 
totals. In that case then typically each line represents one local council ward, and the amount is the 
number of electors in that ward. In some cases a ward may be split into several lines, where parts of the 
ward are associated with different old constituencies. See FileForm.Txt for more information. 

 Include separate sub-ward amount – an advanced option. See FileForm.Txt for more information. 
 

As the dialog indicates, the file FileForm.txt (usually found in the same directory as 
UKElect.Exe) should be consulted for up-to-date details of the file formats currently supported by 
the import process. 
 
After the boundary change information has been imported, the “Update Estimates for New 
Constituencies” option can be selected from the Edit / Edit Constituency Information sub-menu. 
This will use the boundary change information to calculate what the results in the new 
constituencies would have been if they had been fought at the previous election – i.e. the 
“notional” results. Other menu options on this sub-menu are provided to ease the boundary 
change generation process – e.g. to automatically set the areas associated with new constituencies, 
which is done by looking at the areas associated with matching old constituencies. 
 

6.12. Exporting / Importing Estimated (Notional) Results 
In some cases, where boundaries have changed, UK-Elect already includes estimated (notional) 
results – e.g. for use with the 2010 UK General Election. These results can be exported (e.g. as a 
backup file) using the “Export Estimates” option (found on the Forecast menu) and an alternative 
set of notional results imported using the “Import Estimates” option (also found on the Forecast 
menu). Please note that the importing will overwrite the existing estimates, so it is wise to save 
(export) a copy to a different filename first. 
 
It is also possible to import estimates from a spreadsheet comma-separated values (.csv) file using 
the standard import functionality (see Section 4.3). 
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APPENDIX A: FORECASTING METHODS 
 
How UK-Elect works 
The target party support levels are usually input as regional (Scotland, Wales, London etc.) or 
GB/UK opinion poll percentages. (They can however be calculated based on by-election results, 
or early election night results, or on a specified past election, or some combination of these. The 
way in which new results can be converted into national or regional party support levels is also 
highly configurable.) 
 
The difference between the target support levels for the political parties and the support at the 
previous election is applied to each constituency in turn. The way in which the change in 
percentage is applied is highly configurable, e.g.it can be applied in a uniform way or a 
proportional way, or a mix. In addition, behaviour can be tailored to party size, better reflecting 
differences in behaviour whether the parties votes are more concentrated or evenly spread across 
the country. 
 
Each forecast can be done on a regional (up to 6 regions) or national basis, or these can be 
combined. Where one forecasting area forms part of another (e.g. London forms part of England, 
England and Wales, GB, and the UK) the smaller area is forecast first, and the forecast results 
then incorporated into the forecast for the larger area. (Percentages are checked against the targets 
at every stage, so, for example, the previously forecast London results would affect the 
calculations for England, and the English results would in turn affect the overall GB calculations.) 
 
Tactical voting and incumbency can be considered if desired and are highly configurable (see the 
forecasting election results section earlier in this manual).  As an example, the incumbency 
settings can configured on a party or candidate basis, taking account of whether the incumbent 
was previously a first time winner (as some academic studies have suggested that the greatest 
incumvbency advantage is associated with people who won their seats at the preceding election). 
The tactical voting settings can optionally be configured to use defined party vote-transfer 
percentages – e.g to take account of  the preferred “2nd choice” parties of voters. 
 
The forecast results can be blended with previous by-election results and constituency opinion 
polls, which can be adjusted to reduce weighting according to the age of the polls or change in 
national or regional levels of party support since the date of the by-election or poll fieldwork. 

The forecasting methods supported in UK-Elect are:  

• Uniform National Swing 
• Proportional 
• Proportional Loss 
• Proportional Loss With Threshold 
• UK-Elect Method 
• Custom / User-Configurable 
• UK-Elect Experimental Method 
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Uniform National Swing (UNS) 
This method assumes the same uniform swing between parties takes place in every constituency - 
e.g. in every constituency the Tories lose 5% of the total vote and Labour gain 5%. 
 
Advantages 
Quick. Easiest method to understand - a 5% swing to Labour from the Conservatives would gain 
the party all those seats where it is less than 10% behind the Tories (the Tory vote would be 
assumed to fall by 5% and the Labour vote rise by 5%). It is commonly used by the media and has 
a generally good reputation among most psephologists and political scientists because analysis of 
past elections has shown that the national swing often is surprisingly uniform across a range of 
different constituency types and almost irrespective of the starting percentages. In addition it can 
be relatively easily tweaked to improve accuracy provided that a good understanding exists of 
voter behaviour in particular types of constituencies, although it may be noted that the evidence of 
past elections and their forecasts is that such tweaks can sometimes be counterproductive. They 
are usually based on behaviour at the preceding elections – which can change.  
 
Disadvantages 
If used in its pure “uniform” form it is likely to be less accurate than any method that correctly 
makes allowances for human behaviour. Swings are rarely completely uniform even within a 
region. In addition, it is extremely poor at forecasting the votes in cases where a party vote is very 
low or high (if a party has only 4% of the vote in a constituency, it can't lose 5%). It is extremely 
difficult to explain a forecast where one or more of the parties are predicted to have a negative 
number of votes in some constituencies! 
 
Summary 
Uniform Swing is a reasonable choice, which is rarely very inaccurate, and is traditionally a good 
safe choice whenever it is important that predictions agree with those made by most of the media 
(although the proportional-loss based combined method was also commonly used for the 2010 
election – see below). As with other methods it can be modified to try to try to better take account 
of voter behaviour – although not without risk. It is still probably the most commonly used 
technique, both for pre-election forecasting and also as a component of election-night exit-poll 
based forecasting. 

Proportional 
A common alternative to Uniform National Swing that exists in several variations, this method is 
just as easy to calculate. It simply uses the ratio between a party's current opinion poll percentages 
and its percentages at the previous election. 
 
For example, if PartyX got 20% last time, and is currently at 50% in the polls, then the multiplier 
will be 50/20 = 2.5. This multiplier is then applied evenly to PartyX's votes in all constituencies. 
If the resulting vote total is too large or too small then a further multiplication is applied to all the 
party’s votes in the constituency to achieve the correct total number of votes. If, as a result of this 
first pass the national vote totals do not match the target vote percentages then the ratios are 
adjusted and a further forecast made. This process is repeated until the vote target is achieved (or 
the maximum number of iterations reached). It is also possible to modify this system to take 
account of different characteristics of seats, and use different ratios for each of these 
characteristics. 
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Advantages 
Proved to be more accurate than UNS when tried on some past elections. Doesn’t produce 
negative vote totals. Lacks some of the disadvantages of the other methods. As with other 
proportional systems, it can be modified to try to protect against some of the disadvantages 
discussed below – e.g. to prevent wholesale predicted loss of Liberal Democrat seats whenever 
their vote declines significantly nationally! This is usually done by introducing some protective 
mechanism that  applies to seats where their vote is already strong – e.g. some sort of threshold 
above which their votes are protected, so that most of the predicted vote losses come from seats 
where they are weak. (This, in turn, sometimes leads however to extremely low – almost zero - 
vote totals being forecast in their weaker seats, something that in reality more commonly happens 
at by-elections than General Elections). 
 
Disadvantages 
It is likely to be less accurate than any method that correctly makes allowances for human 
behaviour. Swings are rarely in the same ratio in every seat even within a region. When wrong, it 
can be far more inaccurate than the Uniform National Swing method. Many methods based on 
this system proved to be significantly less accurate than the UNS method at forecasting the 2010 
General Election.  As with other proportional systems, it also tends to exaggerate losses where a 
party declines significantly nationwide – for example, when the Liberal Democrat vote declines 
significantly it quite often forecasts zero seats for them – even though past experience of the 
Liberal Democrat and Liberal voting history shows that many Liberal / Liberal Democrat held 
seats are very resilient to even very sharp national vote declines. 
 
Summary 
Rarely used nowadays because the Proportional Loss and Proportional Loss With Threshold 
methods add improvements to it, but still can be a worthwhile method - it quite often produces 
slightly better results than UNS, but don’t take it too seriously - when wrong, it can be very wrong 
– and generally it was wrong in 2010. 
 

Proportional Loss 
An alternative to UNS that gained noticeably in popularity before the 2010 General Election, this 
proportional-loss based method combines aspects of the other two. In each constituency it simply 
uses the ratio between a party's current opinion poll percentages and its percentages at the 
previous election to calculate votes lost and then re-adds those lost votes to the parties which gain 
votes nationally in proportion to their uniform national swing percentages. 
 
For example, if PartyX got 50% last time, and is currently at 25% in the polls, then the multiplier 
will be 25/50 = 0.5. This multiplier is then applied evenly to PartyX's votes in all constituencies. 
In each constituency, the votes lost are then added to those parties which gained votes nationally 
in proportion to their national percentage gain. The result is that the total number of votes stays 
the same as at the previous election in every constituency, and that unlike uniform swing, 
negative vote totals are not possible. 
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Advantages 
Proved to be slightly more accurate than UNS when tried on some past elections. Doesn’t produce 
negative vote totals. As with other proportional system, it can be modified to try to protect against 
some of the disadvantages discussed below and in the “Proportional” section. It can also produce 
a more realistic result when there is a significant transfer of votes directly from one party to 
another, e.g. from an existing party to a newly created one, and thus may be particularly suitable 
for the next UK election. 
 
Disadvantages 
It is likely to be less accurate than any method that correctly makes allowances for human 
behaviour.  Assumes parties can only gain votes in any seat if others lose them nationally – as an 
example, if there were only 3 parties and PartyX gained 20% nationally, PartyY stayed the same, 
and PartyZ lost 20%, then the forecast votes for PartyX and PartyY would remain unchanged in 
every seat where PartyZ didn’t stand (and would remain substantially the same wherever it had a 
low total). In other words, it doesn’t cope well with direct swings between the gaining parties. As 
with other proportional systems, in its pure form it also tends to exaggerate losses where a party 
declines significantly nationwide – for example, when the Liberal Democrat vote declines it quite 
often forecasts zero seats for them 
 
Summary 
A worthwhile method - it can sometimes produce slightly better results than Uniform National 
Swing, although it may also be a lot worse. It may also be useful to replicate some media and 
online forecasts. Be aware that in its un-modified form it may occasionally produce unrealistic 
results in situations where there is a major change in votes for a nationally significant party. That 
said, it can cope well with direct vote support transfers to newly created parties. 
 

Proportional Loss With Threshold 
This variation of Proportional Loss (sometimes called the “Strong Transition Model”) differs only 
in that a threshold can be set (e.g. 20%) which divides voters into “strong” and “weak” categories. 
Below the threshold voters are assumed to be “weak” voters, more likely to switch parties. 
Accordingly, when a parties vote declines it is assumed that the first losses will come from this 
portion of its votes (i.e. more from voters in seats where it is weak), and “weak” and “strong” 
ratios are calculated separately (with the “strong” ratio usually being 1.0 unless all the “weak” 
ratio is calculated as 0.0 – i.e. all the weak voters are assumed to have defected. 
 
Advantages 
Compared to Proportional Loss it much better reflects the situation when the votes for a party 
such as the Liberal Democrats (and the Liberals in the past) decline – despite the reduction in 
votes they tend to retain many of their seats. It was one of the better performing methods in 2010. 
 
Disadvantages 
Although better than Proportional Loss at coping with significant vote declines, it otherwise 
shares the same disadvantages as other proportional methods. 
 



UK-Elect Page 72 
 

Summary 
A worthwhile method that does seem to be an improvement on “pure” Proportional Loss  - it can 
sometimes produce slightly better results than Uniform National Swing, although it may also be a 
lot worse. May also be useful to replicate some media and online forecasts.. 

 

UK-Elect Method 
Note: Different versions of UK-Elect may have different methods associated with them – e.g. the 
“UK-Elect 15 Method” if and when it exists, may be different from the method described here. 
 
The UK-Elect method is based primarily on Proportional Loss With Threshold, with some 
blending with Uniform National Swing functionality. It is highly recommended that this method 
be used with separate regional percentages (at least for Scotland) in addition to national 
percentages, rather than as a simple national percentage based forecast. The default settings 
associated with this method (including the threshold used) have been designed to be particularly 
suitable for use forecasting the next UK General Election.   
 
Advantages 
Mostly the same as the Proportional Loss With Threshold method would have if automatically 
configured for the next election using the preferred UK-Elect defaults. Compared to most 
methods (especially “pure” proportional  systems) it sometimes better reflects the situation when 
the votes for a party such as the Liberal Democrats (and the Liberals in the past) decline – the fact 
that despite the reduction in votes they sometimes (not always) tend to retain more of their seats 
than might be expected.  
 
Disadvantages 
Most of the same disadvantages as the Proportional Loss method, but with some edges softened. 
Also, if detailed constituency polls prove to have been misleading with regard to the real voting 
pattern, then the adjustments made for General Election 2017 may prove counter-productive. 
 
Summary 
Really an easy-to-use variation of Proportional Loss With Threshold (intended for use with a 
combination of national and regional percentages) with additional options automatically set to 
what are hoped to be the appropriate settings for forecasting the next General Election. 
 

Custom / User - Configurable Method 

 
This isn’t a single method – it is actually all of them! It allows access to the detailed settings that 
can be used to define the other forecasting methods, or to create a new one. The configuration 
dialog for this method provides buttons with the names of the main methods on them, which when 
pressed set the advanced options to the appropriate state for those methods. Making a custom 
forecast with the advanced options set appropriately is identical to forecasting by selecting that 
method from the main forecasting configuration dialog. In addition to the previously mentioned 
methods there is a UK-Elect “Experimental” method that can be set on the Custom dialog – it is 
discussed below. 
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Advantages 
Fully configurable – create your own method and test it against past elections by setting the 
forecasting base election and forecasting target percentages source options (found on the main 
forecasting configuration dialog) appropriately. 
 
Disadvantages 
It is possible to create some very dubious methods, and achieve some very strange results! 
 
Summary 
Allows users to see how the other methods are configured, and to create new ones – one of which 
might be the best method for forecasting the next election! 
 

UK-Elect Experimental Method 
 
This is a set of Custom method settings, accessed from the Custom forecast method dialog, that is 
basically the method the developers of UK-Elect are currently experimenting with. It may evolve 
to become a new method in future, or it may be completely replaced. For example, the 
experimental method used from v9.3 onwards was different from that used in v9.2. 
 
Advantages 
It is used to try out possible improvements, and they may turn out to be real improvements that do 
improve the accuracy of forecasts. 
 
Disadvantages 
Because it is “experimental” confidence in any forecasts produced by it is lower than usual. 
 
Summary 
By definition an experimental method, with the advantages and disadvantages that implies. It is 
likely to evolve (or even be completely replaced), and therefore produce different results with 
different versions of UK-Elect. 
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APPENDIX B: ELECTORAL SYSTEMS 

Electoral Systems supported by UK-Elect 
UK-Elect supports seven electoral systems – First Past The Post, the Additional Member System 
(AMS), the Party List system, the Alternative Vote system, the Two Round system, the 
Supplementary Vote system and the Single Transferable Vote (STV) system. In addition, it is 
possible to combine forecasting using the Alternative Vote method for constituencies, and the 
Additional Member System for regional “top-up” seats. 

First Past The Post 
This method is the familiar system used for almost all British elections. Quite simply, the person 
who gets the most votes in each constituency is elected. 

Additional Member System 

This method was chosen for the 1999 Scottish Parliament and Welsh Assembly elections, and the 
2000 London Assembly. Under AMS each voter has two votes – one for an individual which is 
used to elect a constituency representative, and one for a party which is used to elect regional “top 
up” representatives according to a formula which is designed to make the overall result more 
proportional. 
 
In both Scotland and Wales the existing parliamentary boundaries were used for the constituency 
element of this system – the only exception is that the Orkney and Shetland constituency was 
separated into its two parts – and the European constituency boundaries were used for the regional 
element. In Scotland there were 7 top up seats for each of the 8 European constituencies, but in 
Wales there were only 4 for each of the 5 European constituencies. The net result of this is that 
Scotland has a more proportional system than Wales. 
 
The variant of AMS used as the formula to determine how many regional seats were allocated to 
the parties was the d’Hondt method (one which some analysts suggests tends to favour larger 
parties). This method is fully supported by UK-Elect.  
 
Under the d’Hondt formula the first AMS seat is allocated by dividing the number of votes cast 
for each party in a region by the total number of constituency seats won by that party in that 
region plus one. The party with the highest number of votes per seat then wins the first AMS seat. 
For subsequent AMS seats the process is the same, except that the number of AMS seats won so 
far is added to the constituency totals. UK-Elect shows the order in which the seats were 
allocated, and the calculated values at the time of seat allocation (or in the case of unsuccessful 
parties, at the time when the final AMS seat was allocated). 
 
In London the same system was used except that there was only one top-up regional constituency 
covering the whole area. A threshold of 5% was set to ensure that parties falling below that level 
would not be allocated a top-up seat (as would indeed have happened without the threshold). 
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Party List 
This method was chosen for the 1999 European Parliament elections. This can be thought of as 
“AMS without the constituencies” – each voter only has one vote, which is used on a regional 
basis, with seats allocated using the same d’Hondt method used for AMS. 

Alternative Vote 

This method has been used in Australia for the House of Representatives. It is a preferential 
system, i.e. one where voters rank candidates in preferential order (1,2,3…). Any candidate that 
wins an outright majority (more than 50%) of first preference votes is elected; if no candidate 
achieves a majority then the votes of the last placed candidate are redistributed according to their 
voters second preferences. This process continues, with third and subsequent preferences being 
taken into account if necessary, until a candidate achieves an outright majority. 

Two Round  
This method differs from the First Past The Post system only in that if no candidate that wins an 
outright majority in the first round, then a second round is held. The rules for which candidates 
can stand in the second round vary from country to country. In France it typically is the top two 
candidates; a minimum vote percentage (e.g.15%) may also apply. Whichever candidate gets the 
most votes in the second round wins, even if an outright majority is not achieved. 

Single Transferable Vote 

This method is a multi-member system where voters rank their preferred candidates in order (1, 2, 
3 etc.). Surplus votes, and votes from eliminated candidates, are redistributed in accordance with 
voter preferences. STV is used for Northern Ireland Assembly elections, and has been used for 
Scottish local elections from 2007 onwards. One factor to note with STV is that the number of 
candidates for a party in a constituency can affect the result significantly even if the overall vote 
total for the party remains the same – for example, if a party underestimates its potential vote it 
may only field one candidate in a constituency where, if second and subsequent preferences are 
taken into account, it could win two seats. Conversely, fielding too many candidates may split its 
vote and result in too few seats being won. The “Optimize number of candidates for each party” 
option on the forecasting configuration dialog can be used to automatically adjust the number of 
candidates. STV is also strongly affected by vote transfer preferences (see Section 4.9). 

Supplementary Vote 

This method is a single-member system where voters have two votes – a first preference and a 
second preference. Any candidate that receives an absolute majority of first preference votes is 
deemed elected. If no candidate receives a majority then all candidates other than the first two are 
eliminated, and the second preference votes from the eliminated candidates, are redistributed in 
accordance with voter preferences, with any second preference votes for candidates other than the 
top two being discarded.  Whichever candidate then gets the highest vote total wins, even if an 
outright majority is not achieved. SV is used for mayoral elections in England – e.g. to elect the 
Mayor of London. 

Alternative Vote + AMS 

This method combines the Alternative Vote and AMS systems, and is sometimes called “AV+”. 
A form of this was proposed by the Jenkins Commission for the House of Commons: that 
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constituency elections would use AV, and around 15 to 20% of the total seats would be “top-up” 
AMS seats elected from 80 local areas, primarily based on counties and cities. 

Conversions between Electoral Systems  
UK-Elect can convert between electoral systems when forecasting. In order to do a full 
conversion between constituency-only systems and the AMS or Party List regional areas must be 
defined in the election file. The 2001 election provides an example of this; in order to facilitate 
the election type conversions regional areas have been added into the file (the 1999 UK European 
Parliament regions have been used). In circumstances where UK-Elect requires regional areas but 
none are found it can optionally automatically generate these. (Note: it is possible to change the 
regional areas by editing the constituency definition (*.Def) file directly – see Appendix C.) 
 
In order to forecast accurately using the STV, Alternative Vote, Supplementary Vote and Two 
Round systems, it is also important to set voters second and subsequent party preferences – these 
are configured using the Vote Transfer Preferences which form part of the overall party 
configuration, and which can be accessed via the ‘Modify Parties’ option on the Edit menu.  
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APPENDIX C: FILE FORMATS 
 
Note: In order to better understand the UK-Elect file formats it makes sense to update the data 
files being examined to the most recent version. This can be done by loading a results file into 
UK-Elect and then using the “Save All” option on the File menu. This will save all the files 
associated with that election in the format used by the latest version, and in many cases (e.g. for 
map index files) will add comments in the first few lines of each file providing information about 
the file format, which may provide additional information beyond that mentioned in this section. 
 
There are several plain ASCII text files that can be edited by the user, although it is essential that 
time is taken to understand the file format first. 
 
Several must be present: 
  *.ELN - main election files 
  *.DEF - definition of constituencies 
  *.PRV (or .ELR) - Previous results 
  *.OLD (or .OLn or .Oyy, where n is a number and yy is a year) - older results 
 
The others are optional, or created by UK-Elect when necessary: 
  *.BYE - by-elections since last general election 
  *.NEW - latest national results (used on election-night)   
  *.PAR – details of political parties, and groups of parties 
  *.CTY – county/regional definitions - automatically generated if not already present. 
 *.CAN – candidate names for forthcoming elections.  
 *.CIN – change index. This is used when significant boundary changes occur, to calculate 
estimates files based on existing constituencies, or to map old onto new constituencies. 
 *.EST – estimates file. This is a set of estimated (as opposed to actual) results, usually used to 
represent what a result might have been if fought using newer electoral boundaries. The format is 
normally the same as .ELR, .PRV and .OLD files. 
 *.POL – Constituency opinion poll data (same format as by-elections) 
 *.PO2 – National / regional opinion poll data. GeneralElection2010.po2 provides an example of 
this type of file.  
 
The file format of results files (*.NEW, .PRV, .ELR, .BYE, .POL and .OLD), definition files 
(.DEF), candidates files (*.CAN) and the county and regional definition files (.CTY) are 
reasonably straightforward - as can be seen when they are printed and examined. Direct editing is 
not normally necessary or recommended, but may be useful in a few cases, e.g. if changing the 
regional areas used for some electoral systems. 
 
Consult FILEFORM.TXT for more details of all UK-Elect file formats. Also, try using the “Save 
All” option from within UK-Elect and then reading the comments written into the files. 
 
All files are automatically generated when the “New Election” option is chosen. Most are also 
automatically updated when the relevant editing operations are performed from within UK-Elect. 
 
Please note that files should ALWAYS be backed up before any editing is done! 


